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Coral reef ecosystems are the most diverse on earth, and their subsistence is being

threatened by natural and adverse anthropogenic patterns and processes. In an effort to

understand and protect these marine environments, several programs have outlined

strategies and initiatives. For example, the United States Coral Reef Task Force's

Mapping and Information Working Group has outlined a specific goal to map all coral

reefs below 30 m depth by 2009. This study contributes to achieving that goal for three

sites around the island of Tutuila, American Samoa, lying in the heart of the South

Pacific. American Samoa, a U.S. territory, is home to the Fagatele Bay National Marine

Sanctuary, the smallest and most remote in the United States, and to the National Park of

American Samoa. Extensive modern scientific surveys were implemented around the

territory in 2001 and have since continued and increased. The presence of protected

areas and the existence of scientific data collected with state of the art technology have
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made the site a priority for the Coral Reef Task Force. In this study, methods for

classifying surficial seafloor characteristics as bathymetric position index (BPI) zones

and structures were developed and applied to the study sites. BPI zones and structures

were classified by using algorithms that combine high-resolution (1 m) multibeam

bathymetry and its derivatives: bathymetric position index at multiple scales and slope.

The development of algorithms and the classification scheme involved the use of

historical and current classification studies and three-dimensional visualization. In

addition, the BPI zones and structures were compared to limited biological, geological,

and physical attributes recorded during accuracy assessment surveys (photos) and towed

diver surveys (video). A rugosity (surface ratio) analysis was added to the study to give a

picture of the seafloor roughness. The BPI zone and structure classifications overlap and

extend existing classifications from Ikonos satellite imagery for water depths shallower

than 30 m. Methods, data and classifications developed and applied in this study will be

available to the public as a benthic habitat mapping tool (ArcGIS extension), in an online

GIS data archive, and on a compact disc attached to this thesis. They contribute to a

broader understanding of the marine and coastal environment and will serve as a baseline

of information for benthic habitat mapping and future biological, ecological, and

geological surveys. The baseline gives a good indication of characteristics that may

indicate areas of high biodiversity. The final maps presented here are especially useful to

managers, researchers and scientists that seek to establish and monitor a wider and more

effective network of marine and coastal protection.
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1. Introduction

Marine and coastal environments are a vast frontier for exploration. As scientists

across the world have already mapped the surfaces of other planets, our own begs for

researchers to discover terra incognita. The oceans cover over 70% of the globe, but only

5% of reefs are mapped at a resolution of 1:100,000 or better (Miller and Crosby 1998).

With increased interest in resources from marine and coastal environments, researchers

are determinedly making large joint efforts to understand where the resources come from

and what is needed to sustain them. Coral reefs, along with tropical rainforests, are the

most diverse ecosystems on earth, and their subsistence is being threatened by natural and

adverse anthropogenic patterns and processes (Evans et al. 2002).

In the effort to understand and protect ocean resources, several agencies and

governmental organizations have been established. Many of them have outlined specific

strategies and initiatives to support marine environments. In the forefront of such

strategies is the need for seafloor mapping. To understand and protect these valuable

environments, we need to know what exists there. More specifically, we need to know

what type of fine-scale terrain is on the seafloor in order to study specific resources that

are known to prefer particular terrains and physical environmental factors. A prominent

entity was established by the National Oceanic and Atmospheric Administration NOAA)

in June 1998 as an overseer of coral reef protection. This entity, known as the United

States Coral Reef Task Force (CRTF), has multiple working groups. This thesis

addresses the goals of one of these, the Mapping and Information Working Group.
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Specifically, it contributes to the mapping of all U.S. coral reefs below 30 m depth by

2009 by quantitatively mapping the seafloor below 30 m depth at sites around American

Samoa (lEvans et al. 2002). American Samoa is in the heart of the South Pacific about

4,700 km southwest of Honolulu, Hawaii and 1,200 km northeast of Fiji.

High-resolution multibearn bathymetry, derivatives of bathymetry (bathymetric

position index, slope and rugosity), backscatter imagery and in situ visual survey data

have been combined in a geographic information system (GIS). These data are

supplemented by three-dimensional (3D) visualization. Within this study, methods were

developed for benthic mapping and applied to three sites around American Samoa, a new

classification scheme was developed for bathymetric position index (BPI) zones

(depressions, slopes, flats, crests) and structures (finer features within zones) around the

study sites, and visual survey information was associated with the results.

In order to produce useful BPI zone and structure maps along with rugosity maps

for each study site, it was necessary and beneficial to review past studies that have used

various techniques for classifying seafloor environments. Historical studies have used

data from multibeam mapping systems, side scan sonar systems, visual surveys (e.g.

underwater photography, videography, grab samples, species counts), existing geological

and habitat maps, and other data from related sources (e.g. Davis et al. 1986, Hall et al.

1999, Sotheran et al. 1997, Tyce 1986). Researchers in each study have taken a slightly

different approach depending on their end goal.

For the sites around American Samoa, extensive data have been collected since

2001 including multibeam bathymetry and backscatter, towed diver videos and field
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notes, accuracy assessment photography and field notes, and even information from a

rebreather dive (Wright et at. 2002). The existence of detailed information about them

and their remote location has made American Samoa's coral reefs a priority site for

benthic mapping. American Samoa is home to the smallest and most remote National

Marine Sanctuary and a portion of its northern coast is part of the National Park Service

(the National Park of American Samoa).

Methods, data and classifications developed in this project will soon be available

through a benthic habitat mapping tool that is being co-developed with Oregon State

University and NOAA's Coastal Services Center (CSC) as well as through the Fagatele

Bay National Marine Sanctuary GIS Data Archive (dusk.geo.orst.eduldjl/samoa). They

contribute to a national and global investigation of the world's marine and coastal

environment. The classifications and associated marine life information are tools for

designing management programs for the Fagatele Bay National Marine Sanctuary, the

National Park of American Samoa, and other marine reserves in the territory. They are a

baseline of information for policy makers and managers to establish a wider and more

effective network of marine protection.

2. Justification for Research

2.1. Threats to Coral Reef Ecosystems

Tropical coral reefs are in the forefront of scientific exploration as increasing

amounts of resources are being discovered in and offered by their ecosystems. For



example, they are known for their high physical complexity and biological diversity

(Reaka-Kudla 1997, Miller and Crosby 1998). The high productivity of these ecosystems

demands a quantifiable analysis of the complexity and diversity present there. Many

people depend on the resources and services that coral reef ecosystems provide, and the

direct connection with adjacent coastal ecosystems is important to increasing coastal

populations (Cufliton 1998). Natural and anthropogenic processes threaten natural and

cultural resources in these areas in the form of storms, global warming, sea water level

rise, disease, overfishing, ship grounding, sediment runoff, trade in coral and live reef

species, marine debris, invasive species, security training activities, offshore oil and gas

exploration, and coral bleaching (Miller and Crosby 1998, Strategy 2002). Although

corals can recover from natural disasters, their ecosystems may not bounce back in the

face of destructive anthropogenic threats (Miller and Crosby 1998, Weier 2001, Green et

cii. 1999). The cumulative threats to these little understood ecosystems are detrimental.

About 27% of monitored reef formations have reportedly been lost and as much as 32%

are at risk of loss in the next 20-30 years (Wilkinson 2000, Weier 2001). This makes

clear the need for a better understanding and better monitoring of coral reef ecosystems,

and accurate mapping is the first step in this process.

2.2 Understanding and Monitoring Coral Reefs

Several major players oversee research and monitoring of coral reefs in the United

States. NOAA, a major leader in these efforts, has established and chaired programs and

initiatives that help understand and protect natural and cultural resources including the
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National Marine Sanctuary Program (NMS) (Evans et al. 2002a), the International Coral

Reef Initiative (ICRI), the CRTF (co-chaired by the Secretary of the Interior and the

Secretary of Commerce). Each program has furthered coral reef protection through the

development and implementation of strategies and site-specific initiatives. The CRTF

oversees the implementation of the Presidential Executive Order 13089 (E012089) for

Coral Reef Protection and guides and supports the U.S. Coral Reef Initiative (Clinton

1998). ICRI partners also use the framework presented by E013089, and they have

collaborated to form the U.S. All Islands Coral Reef Initiative Strategy Coordinating

Committee (USAICRICC) (1999).

The TJSAICRICC has influenced individual island nations and territories to form

their own initiatives. Hence, the American Samoa Coral Reef Initiative formed the

American Samoa Coral Reef Advisory Group (Advisory Group) to oversee coral reef

management in the territory (USAICRICC 1999). The idea for implementing coral reef

management with the involvement of several agencies and government levels is

supported by the Advisory Group and with Integrated Coastal Management (1CM)

planning. Olsen and Christie (2000) state that the overall goal of 1CM is to improve the

quality of life of human communities who depend on coastal resources while maintaining

the biological diversity and productivity of coastal ecosystems. This effort contributes to

such a goal.

NOAA's NMS Program promotes objectives and themes outlined by a National

Coral Reef Action Strategy reported to Congress in 2002. There are two major themes in

this report: to understand coral reef ecosystems and to reduce adverse human impacts to



coral reef ecosystems. This study focuses on four goals for the first theme in this action

strategy, namely:

(1) Map All U.S. Coral Reefs
(2) Assess, Monitor and Forecast Coral Reef Health
(3) Conduct Strategic Research
(4) Understand Social and Economic Factors

Led by the goal to map all U.S. coral reefs, the objectives of the Mapping and

Information Working Group in the CRTF will be approached with the benthic maps

produced by this project. The group's objectives outline the need for (1) production of

comprehensive digital maps of all shallow (<30 meters) coral reefs and (2) the

characterization of priority reef systems in water depths> 30 m in the U.S. and Trust

Territories by 2009 (NOAA: USDOC 2002). Priority reef systems for mapping include

marine protected areas and areas where state-of-the-art technology and data sources can

be adapted for characterizations.

3. Background of Ocean Exploration and Mapping

3.1. Survey Methods

Numerous means of data collection exist for seafloor exploration, including

multibeam mapping, side-scan sonar, single beam mapping, remote sensing, SCUBA

diving, towed diver surveys, rebreather diving, differential global positioning systems,

submersibles, remotely operated vehicles, grab sampling, species counts, underwater

photography, and visual observations. A brief discussion of seafloor exploration



7

demonstrates the significant advances that science has made in developing and utilizing

its resources for mapping.

Seafloor data collection and mapping of the seafloor contribute to the

management of marine resources, the placement of marine protected areas (Franklin et al.

2003), the characterization of essential fish habitats, and relaxed decision making. Visual

surveys have been incorporated in most successful seafloor explorations. Visual data as a

ground truthing mechanism have proven to be an asset to the development of accurate

seafloor maps. Since World War II, SCUBA used for photography, submersibles,

seismic reflection profiles, and sediment-coring have supported deep-sea sedimentology

(Luepke 1998). Photography, video and visual observations via SCUBA diving,

snorkeling, rebreather (mixed-gas) diving, submersible surveys, remotely operated

vehicles, and towed-diver surveys have contributed to countless ocean and coastal studies

(e.g. Ninio et al. 2003, Franklin etal. 2003, Wright etal. 2002, Pyle 2001, Schmal etal.

2003, Collins et al. 2002, Cutter ci' al. 2003, Wargo Rub 2002). Further visual

assessment for seafloor exploration involves sampling and detailed survey of sediments,

species, water characteristics, salinity, temperature, magnetics and other study specific

features/components. (Hurst and Karson 2004, Collins et al. 2002, Green et al. 1999,

Greene and Bizzarro 2003, Franklin et al. 2003, Diaz 2000, Wright 1999).

Photography, videography, and visual observations and assessment are necessary

for accurate seafloor characterizations that use other resources such as remotely sensed

data and acoustically derived data (Cutter et al. 2003). Historically, acoustic single-beam

mapping systems and side-scan sonar contributed greatly to the understanding of the
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seafloor (Hughes Clarke et al. 1996, Hurst and Karson 2004, Collins et al. 2002). Use of

echo sounding for ocean exploration began in the 1 920s (Tyce 1986), and echo sounding

with the Ewing piston corer was used soon after World War II (Luepke 1998). During

that time, users of the technology were few, but included the U.S. Coast Guard and the

U.S. Navy. After World War II, the military's need for mapping lost vessels and their

interest in detailed bathymetry and physical seafloor features led to the development of

deep seafloor exploration using side-looking sonar systems (Luepke 1998, Tyce 1986).

The first side-looking sonar system was developed in 1960 for shallow water (Tyce

1986). In the 1970s, the first swath sonar mapping systems were made available for

civilian science (Mayer et al. 2000, Tyce 1986). During the 1 970s, increased digital

computing capabilities led to development of sonar mapping. However, limitations

associated with electronic complexity, bulky and heavy vehicles, and unforgiving

weather at sea still hampered wide use of the mapping systems. In the early 1980s, the

first towed mapping system (Sea MARC II) that provided both swath bathymetry (depth)

and side-looking sonar imagery was employed (Tyce 1986).

Since then, rapid technological progress has provided multibeam mapping

systems that record over 100 beams of data with wide beam widths that allow surveys to

ensonify massive areas of the seafloor with high accuracy (Mayer et al. 2000). The

acoustic beams form a swath that fans out up to several times the water depth (Figure 1).

Muitibeam mapping systems are set up on research vessels that navigate back and forth

across the study area until the entire site is covered. During the survey, adjustments are

made for sound velocity, heave, roll, pitch, and speed (.-3-12 knots). The position of the



boat is obtained from 24- hour precise code Global Positioning System (GPS) navigation

fixing from two receivers aboard the boat. Data are post-processed for tidal fluctuations

upon completion

Figure 1: Multibeam Mapping
System. This image portrays
the swath of acoustic signals
that resonated from the Simrad
Kongsberg EM3000 to collect
bathymetry and backscatter.
The swath shown deeper in the
water column portrays a towed
side scan sonar. (Courtesy of
NOS Coast Survey at
http :llchartmaker.ncd.noaa.gov
/hsd/wrecks.htm)

of field surveys, and data are cleaned by flagging and/or removing outliers (Wright et al.

2002). Multibeam mapping systems also collect backscatter values, or the intensity of

acoustic return. Backscatter is often suitable for classifying seafloor bottom

characteristics (e.g. consolidated versus unconsolidated, sediments versus lava flows).

Multibeam bathymetry and backscatter have successfully been used for numerous

studies providing a baseline of information for seafloor exploration. Such studies report a

wealth of information on topics that include but are not limited to geological features

(Davis et al. 1986), morphology (Guan and Flood 2001, Diaz 2000), fault and rift

patterns (Hurst and Karson 2004), mid-ocean ridges (Cowie et al. 1994, Muller et al.

1997), spreading centers (Wright 1999), marine protected areas, species distribution

(Schmal et al. 2003), seabed classification (e.g. Collins and Galloway 1998, Cutter et al.

2003, Dartnell and Gardner (in press), Guan and Flood 2001, Hughes Clarke et at. 1996,
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Hurst and Karson 2004, Pratson and Edwards 1996, Wilder and Norris 2002), habitat

classifications (e.g. Ninio et at. 2003, Magorrian et at. 1995, Schmal et at. 2003), and

many other topics addressing combinations of pattern, process, and species relationships.

3.2 Integration of Ocean Data in GIS

The large amount of data that have been collected over decades of research across

the world's oceans is valuable for understanding and protecting the vast amount of

resources that the oceans support. Unfortunately, these data are often collected, but

because of limited technologies, lack of expertise or lack of funds to interpret the data,

they are left archived and unused. The integration of marine data in GIS has proven to be

a useful tool for advancing marine and coastal research, science and management, geo-

referenced mapping, modeling and decision making (e.g. Wright and Bartlett 2000,

Valavanis 2002). Wright and Goodchild (1994) suggest that oceanography can benefit

from GIS as much as GIS can benefit from oceanography. This is supported by the

presentation of GIS needs in ocean exploration that include the creation of three and four

dimensional displays, support for very large data sets sometimes with multiple scales, and

capabilities that can handle the dynamic nature of the marine environment (e.g. Wright

and Goodchild 1994, Lockwood and Li 1995). Marine GIS professionals also agree that

the need for accurate and complete metadata is crucial for the field (MMUG 2003a).

Metadata should explain the history of a data set with information about its sources,

accuracy, positioning methods, coordinate system, original scale, and methodology for

data collection (Greene et al. in press, 2004). It is also helpful to users, especially when
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using historically-collected data, to know the original purpose of the data. While GIS

offers a multitude of benefits to ocean exploration, there is room for improvement.

Greene et al. (in press, 2004) discuss the pitfalls of GIS in marine benthic habitat

mapping, including critical metadata issues. A shared concern of researchers of the

marine environment is the need for a protocol for metadata to report upon type and

quality of data (e.g. accuracy and original scales of sources). Greene et al. (in press,

2004) add that metadata need to include the history of data interpretation and an

indication of the genealogy (interpreters and authors of the maps).

An asset to marine resource managers and researchers is the ability of GIS to

integrate several data types (e.g. Hall et al. 1994). GIS also provide a means for finding

data gaps, providing a base for sampling designs, coordinating between database

managers and program staff, creating formats that are sharable across agencies,

developing management options and presenting options for visual display (Hall et al.

1994, Wright 1996). For example, Rubec and Palacol (2002) present the use of GIS for

coordinating the farming of coral reef invertebrates. They explored the effects fishing

practices have on coral reefs and other coastal habitats by combining terrestrial and

marine zoning, bathymetry, ocean currents, salinity, and temperature. The GIS provided

maps for community decision making, marine protected area designations, and decisions

on determining suitable areas for mariculture (Rubec and Palacol 2002). Integrated GIS

allow users to integrate data sets such as high-resolution bathymetry with backscatter

data, towed diver video footage, photography, and remotely operated vehicle and

submersible observations.
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In support of this study, it is important to recognize that geo-referenced habitat-

species maps and habitat assessments are essential, even critical, to the foundation of

marine habitat management (NOAA: USDOC 2002). The availability of modern

technology and computer resources allow researchers, scientists, managers, and end users

at every level to participate in marine management.

4. Seafloor Classification Approaches

The first deep-sea sediments classification was made during the H.M.S.

Challenger expedition from 1872 to 1876. Reports from the Challenger mission have

driven oceanographic work as a primary reference since that time (Luepke 1998). With

the most modern technologies, this study aims to achieve detailed classifications that will

build further on the historical data sets that have resulted since the Challenger expedition.

The aim of this study is to provide geo-referenced maps and data layers that are useable

in a GIS to characterize benthic habitats and their associated species. Considering the

need to spatially relate patterns, process, and species, studies were reviewed that

combined a seabed classification with habitat types in order to make predictive habitat-

species maps (Greene and Bizzarro 2003, Hall et al. 1994, Franklin et al. 2003, lampietro

pers. comm. 2004, Ninio et al. 2003, Magorrian et al. 1995, Schmal et al. 2003, Sotheran

et al. 1997, Whitmire 2003, Zajac et al. 2003). The studies that could make connections

between species and habitats generally focused on certain species. They also had access
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to some kind of visually observed survey data (e.g. transect video, still photos, grab

samples, etc.) to make qualitative and/or quantitative inferences.

A significant ongoing goal in seafloor exploration is to define a common

classification scheme that all characterization studies can use effectively and efficiently.

The development of a common classification scheme would make sharing results and

data easier. However, in this effort there is an understanding among researchers,

scientists, and managers that the use of a common classification scheme is not a reality

yet. The seafloor mapping community is striving for such a scheme at regional and local

levels (e.g. MMUG 2003, AIlee et al. 2000). So far, there are a few extensive

classification schemes that have been adopted for regional studies. They are most often

hierarchical schemes that can be expanded and collapsed for different mapping interests.

So-called habitat classification studies have used methods to integrate multibeam

bathymetry with backscatter, video, and photography. In an effort to characterize

essential fish habitats from offshore California, Greene and Bizzarro (2003) added small

scale industry and government data, geologic maps and existing habitat maps to find

areas and locations of interpreted seafloor habitat types. They classified substrate types

(hard, soft, and mixed), slope, major geomorphic features (submarine canyons,

seamounts, and prominent banks), and depths. The resulting maps show probable

locations of various habitats. They applied a scheme modified after Greene et al. (1999).

The Greene et al. (1999) scheme describes broad classes that can be interpreted from

remote sensing imagery including megahabitats (based on depth and general

physiographic boundaries), seafloor indurations (based on substrate hardness),
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meso/macrohabitats (based on scale), modifiers for textural and lithologic relationships,

seafloor slope, seafloor complexity, and geologic units. The scheme continues with more

detailed habitat characteristics interpreted from video, still photos or direct observation.

They are macro/microhabitats (based on observed small-scale seafloor features), seafloor

slope (estimated from in situ surveys), and seafloor complexity (estimated rugosity).

Weiss (2001) made a unique classification scheme for understanding watershed

metrics by using a topographic position and landform analysis. To form a topographic

position index (TPI) he used algorithms that perform an analysis on each grid cell in an

elevation model. Each grid cell is assigned a TPI value that indicates its position (higher

than, lower than, or the same elevation) in the overall landscape. By combining TPI with

slope position, Weiss (2001) found methods to apply a landform classification scheme to

watersheds around Mt. Hood, Oregon, USA and the west slope of the Oregon Cascades.

The scheme includes 10 landform classes: canyons, deeply incised streams; midsiope

drainages, shallow valleys; upland drainages, headwaters; U-shape valleys; plains; open

slopes; upper slopes, mesas; local ridges/hills in valleys, midsiope ridges, small hills in

plains; mountain tops, high ridges. Weiss (2001) considered two scales of landforrns in

order to incorporate structures found within broad landscapes. His techniques are well

suited to benthic classifications that serve as a predictor for habitat suitability and

biodiversity (Guisan et al. 1999).

lampietro and Kvitek (2002) derived descriptive grids from multibeam

bathymetry to quantify seafloor habitats for the nearshore environment of the entire

Monterey peninsula in central California, USA with GIS. They followed Weiss's (2001)
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methods to develop TPI grids that at a fine-scale can describe micro- and macro-scale

habitats while at a broad-scale can describe meso- and mega-scale habitats. Another

derivative of bathymetry that they applied was rugosity. Rugosity is a measure of

roughness or bumpiness (classified as high, medium, and low) that is quantified with a

ratio of surface area to planar area.

Coops et al. (1998) further developed and tested procedures to predict

topographic position from digital elevation models for species mapping. In their study

topographic position is a "loosely defined variable" that attempts to describe topography

with spatial relationships. Quantitative assessments of such terrains are rarely reported.

Topographic position can help researchers understand how patterns, processes and

species are spatially related. While qualitative analyses can describe processes on slopes

at different scales, a quantitative assessment determines primary units within the context

of a process. Depending on the scale of the landscape in interest, more or fewer divisions

of topographic position may be quantified. Coops et aL's overview describes a landscape

classification scheme by Speight (1990). Speight (1990) defined morphology types with

eleven different classes: crests, depressions (open and closed), flats, slopes (upper, mid,

lower and simple), ridges, and hillocks. The topographic position analysis in this study

incorporates local relief, elevation percentile, plan and profile curvature, slope, and

variance threshold. After defining crests, depressions, flats and slopes, the study goes

further to define the more detailed classes. Unfortunately, the study does not attempt to

subdivide the depressions into open and closed, though the classification scheme
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recognizes the need for the distinction. Also, because of their fine scale complexity,

hillocks and ridges were not quantified (Coops et al. 1998).

Some historical studies have taken approaches to relate topographic features with

populations of particular species. Schmal et al. (2003) used multibeam bathymetric maps

to guide submersibles that allowed the researchers to identify detailed biotopes and

species within geomorphic zones (e.g. coral species zones within midshelf banks (<36 m

depth) or within banks (< 50 m depth) or on the soft bottom). The bathymetry served as

an effective base layer in a GIS to use for their investigation. Another study that

effectively related species to their habitat locations used side scan sonar mosaics to find

the relationship between population abundance and the benthoscape (undersea

landscapes) (Zajac et al. 2003). With the use of backscatter imagery, they classified large

scale benthoscapes such as muddy sands, fine sands and muds, boulder, cobble and

outcrop, sand wave fields, and mixed. They paid close attention to transitions between

benthoscapes where infaunal populations were readily identified at a finer scale.

The approach taken in this thesis takes into consideration the many applications of

many types of data that are used for benthic habitat mapping (e.g. Hall et al. 1999). Most

often there is a need for a baseline of information. Usually, the baseline, or framework,

used for a habitat study is a basic data set that describes the surficial characteristics of the

seafloor in some useful fashion (Dartnell and Gardner, in press). Then, based on what the

seafloor looks like, a biologist, geologist, ecologist, geophysicist, or other interested party

will supplement that framework with specific data sets. A biologist may add a layer of

information about amount of relief or the thickness of sediments. A geologist may add
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data revealing sediment size or rock type. Depending on the interest of the research,

different layers of information are needed. Therefore, a method has been chosen that

results in separate data sets that may be combined at different scales and in different

combinations to serve as a baseline of information for researchers, scientists and

managers. Partners in this study (the American Samoa GIS User Group, the Center for

Coastal Ocean Mapping in the Department of Marine Science at University of South

Florida, and CRED) have expressed interest in starting with descriptive benthic

classification maps at priority sites as a means for understanding coral reef ecosystems.

5. Study Site and its Threats

American Samoa, a small, remote territory in the heart of the South Pacific, is the

only United States territory south of the equator. It lies about 14° south of the equator,

about 4,700 km southwest of Honolulu, Hawaii (Figure 2). It neighbors the independent

Nation of (western) Samoa as the eastern portion of the Samoan archipelago. American

Samoa's five volcanic islands (Tutuila, Aunu'u, Ofu, Olosega, and Ta'u) and two coral

atolls (Rose and Swains) are surrounded by the only true tropical reefs in United States

waters. The Samoan archipelago is being watched closely by researchers since the

discovery of the Vailulu'u Seamount, an active volcano, located 45 km east of Ta'u the

most eastern island in the chain (Hart et a!, 2000).
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Figure 2: Location Map of American Samoa. The United State Territory that is the home for
priority coral reef ecosystems that are part of the National Action Plan to Conserve Coral Reefs.
American Samoa is part of the Samoan archipelago and is comprised of 5 volcanic islands and 2
coral atolls. (Courtesy of the Park of at http://www.nps.gov/npsa/maproom.htm)

Coral reef ecosystems around American Samoa continually face natural and

anthropogenic threats. For example, coral bleaching events related to sea temperature rise

have increased in the region, including a particularly destructive event in 1994 (FBNMS

2004). An infestation of Crown-of-Thorns starfish killed vast amounts of coral in the late

1970s owing to their habits of eating live coral (Craig 2002). In addition, coral around

the South Pacific islands are threatened annually by tropical cyclones. American Samoa

suffered from the effects of hurricane Ofa in 1990, hurricane Val in 1991, and most

recently hurricane Heta in January 2004 (Craig 2002, FBNMS 1999, FEMA 2004).

Anthropogenic threats challenge and stunt coral reef recovery from natural disasters.

Fishing practices such as gill netting, spear fishing, poison and dynamite are limited by
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the Government of American Samoa and the American Samoa Coastal Management

Program, but many areas are still exploited illegally. A rapid increase of population of

American Samoa has directly affected coral reef ecosystem health and sustainability.

People exploit fisheries by gleaning the reefs as the requirement for food increases.

Lacking space in landfills, residents leave garbage in and near streams that flush into the

ocean. Increased erosion and run-off problems associated with construction, agriculture

and sewage are sources of non-point pollution and cumulative impacts (ASG: DOC

2004).

In 1986, the efforts to protect coral reef ecosystems around American Samoa were

emphasized by the establishment of the smallest and most remote National Marine

Sanctuary in United States waters (FBNMS 2002). The designation of the Fagatele Bay

National Marine Sanctuary and the already existing National Park of American Samoa

covering parts of the islands of Tutuila, Ofu and Ta'u make the seafloor and the coral reef

ecosystems surrounding the islands a priority for the United States. Additionally, since

2001, collection of extensive survey data makes the territory a priority site for

implementing the National Coral Reef Action Strategy. The islands and atolls of

American Samoa are surrounded by high priority coral reefs that need to be characterized

beyond 30 m depth by 2009 to reach the goals of the Coral Reef Task Force (NOAA:

USDOC 2002).

6. Data Collection
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6.1. Multibeam Bathymetry Collection

The first scientific surveys of deep water coral reef ecosystems around American

Samoa were conducted in April and May of 2001 (Wright et al. 2002; Wright 2002).

Bathymetric data around American Samoa from 3 to 160 m depth were collected in

2001 and 2002 with the Kongsberg Simrad EM3000, 300 kHz, multibeam mapping

system. The 2001 survey resulted in bathymetry and backscatter for Fagatele Bay, part of

the National Park, Pago Pago Harbor, the western portion of Taema Bank, and Faga'itua

Bay (Figure 3). Sites surveyed in November 2002 are eastern Taema Bank, Coconut

Point, Fagatele Bay, and Vatia Bay (Figure 3).

Figure 3: High-resolution (1 2 m) Multibeam Bathymetry around Tutuila, American Samoa. In
Geographic, WGS84, surveys were performed in April and May of 2001 and November of 2002.

This study focuses on three of the study sites around Tutuila: Fagatele Bay

National Marine Sanctuary (FBNMS), Taema Bank, and Coconut Point. FBNMS (Figure

4a), the smallest (0.65 km2), most remote, and least explored of the thirteen National
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Marine Sanctuaries in United States waters, is a flooded caldera on the southern coast of

Tutuila surrounded by jungle and a few short, thin sandy beaches. The seaward boundary

is a straight line from Fagatele Point (14°22'15" 5, 170°46'S" W) to the Matautuloa

Benchmark (14°22'18"S, 170°45'35"W) (FBNMS 2004). Taema Bank (Figure 4b) is a

long, narrow submarine platform off the south coast of Tutuila outside the mouth of Pago

Pago harbor and is the southerly remnant of the sunken caldera that now forms the harbor

(Steams 1944, Flanigan 1983). Coconut Point is a small peninsula extending into Pala

Lagoon near the international airport. The bathymetry for Coconut Point (Figure 4c) is

actually just offshore from the international airport, outside the lagoon, where the

seafloor deepens sharply off a reef flat.

Figure 4: Study Sites:
Three-dimensional.
Screen captures of
each study site showing
3D bathymetry where
pink is the most
shallow and dark
purple is the deepest.
Bathymetry is labeled
in meters.

(4a) Fagatele Bay
(4b) Taema Bank
(4c) Coconut Point
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6.2. Backscatter Analysis and Limitations

Backscatter grids from the 2001 multibeam bathymetry survey are in the form of

geotiffs. The images hold attributes for three color bands: green, red, and blue. The

intensity of the colors reflects the intensity of the acoustic return that was recorded at

each location (Figure 5). The lighter colors symbolize areas that have a high acoustic

return, or substrates that are highly reflective like volcanic rock. The darker colors

symbolize a lower return, or sound absorbent substrates like sand and mud. As depth

increases, the reliability of backscatter strength decreases. Backscatter is highly



dependent on reflectance angles, and becomes more unpredictable and almost

uncorrectable in deeper water (Blondel and Murton 1997). This is a limitation of

backscatter that was not solved for this project. In this study, the imagery was useful

only for broader classifications.

Figure 5: Georeferenced
Backscatter. Backscatter was
recorded during a multibeam
mapping survey in (5a)
Fagatele Bay National Marine
Sanctuary and at (Sb) Taema
Bank (Western) in April and
May 2001. Light areas are
sites of high acoustic return
and dark areas are sites of low
acoustic return.
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6.2.1. Limitations

The backscatter images for these study sites are not at a scale appropriate for

interpretation of detailed substrate. They give a quite broad picture of the sea floor and

are, therefore, better suited as a supplement for an accuracy assessment of the

classifications. Likely, the complexity of the study sites caused artifacts in the

backscatter. Smoother areas like the Shalebeds and Cannery Row off of the Monterey,

California, USA coast are classified well by backscatter. They are dominated by soft

sediments with scattered rocky outcrops and mixed substrates. In contrast, at sites around

American Samoa acoustic signals return obscure intensity values because the signals
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"bounce" off several surfaces before returning to the survey instrument. While some of

what look like pinnacles and patches on Taema Bank become visible with lighter colors

in the imagery, most of the linear white areas in the Taema Bank backscatter are areas

with no data. The limitations of the only available backscatter for American Samoa study

sites are disappointing, since the information is valuable to habitat mapping. Even in its

absence, though, a baseline of information is available from the classifications of other

data sources. Generally backscatter can be limited by factors such as the lack of

groundtruthing, unnoticed changes in system parameters, changes in operational modes

for deeper waters, errors accumulated from vessel speed, effects of roll and pitch, and

repetition rates (Diaz 2000).

6.3. Visual Data Collection

Visual survey data were incorporated with the BPT zones, structures and rugosity

classifications as a measure of accuracy and will allow scientists to relate benthic species

with the classifications. The classified maps will guide further biological and ecological

surveys. Visual surveys play a very important role in benthic mapping. They provide a

remarkable source for habitat assessment, in turn acting as a resource to ground truth the

spatial analysis of remotely sensed data and sonar imagery. The BPI zones, structures,

backscatter, and rugosity are most useful when supplemented by accuracy assessment

from in situ visual surveys. Visual surveys have been conducted across much of the

seascape around American Samoa. They include video from rebreather and towed-diver

surveys, underwater photographs, and extensive field notes.



6.3.1. Towed Diver Surveys

A towed-diver survey consists of towing two divers on tow-boards behind a

SafeBoat moving at about 1-2 mph. Each tow-board has two cameras fastened to them.

One camera records transects facing downward, and the other records forward. The

divers document the benthic features that they observe (CREI 2003). NOAA's Coral

Reef Ecosystem Division (CRED) conducted a towed-diver survey over transects around

Tutuila in March 2002. To supplement the video footage, two towed-divers recorded

habitat complexity, geological structures, associated taxa and debris, temperature and

pressure. Divers visually classified habitats as coral, sand, algae, and rock, and they

classified habitat complexity as very high, high, medium-high, medium, medium-low,

and low. Towed diver survey results (segmented vector data) can be overlain on the

derived rugosity to assess the accuracy of classifications.

Towed diver survey data were classified with attributes for each segment of the

survey transects. The complexity that was attributed for the tow line does not match the

rugosity grid derived with spatial analysis. If rugosity can, indeed, indicate complexity,

then the tow lines are not a helpful groundtruthing mechanism. The limitation comes

from the nature of the dives. The divers' average depth was limited to safe diving limits

(-30 m). Their visibility was about 25 m. So, the tow lines are classified relative to

visibility and diver interpretation. These qualitative data are very valuable for shallow

water benthic mapping. However, relative to deeper water benthic habitats, the tow line
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attributes can not be extended with quantifiable accuracy; there is an obvious need for

more groundtruthing via submersible and/or remotely-operated vehicle (ROY) surveys.

6.3.2. Accuracy Assessment Surveys

The National Park of American Samoa and others performed accuracy assessment

and ground validation surveys to collect visual data around the island of Tutuila (A.

Graves, pers. comm. 2001). The team collected data at over 500 discrete points (Figure

6). Many of the points are located in study sites that have also been surveyed with

multibeam mapping. The attributes for the sites are not complete for every point;

Locations of Photos at Submerged Sites
around Tutuila, American Samoa

ninut

utuiIa -
Faoatele Bay

Vatia
Bay

National Marine a on 1 2 3 Ascuracy Assessment Points
Sanctuary 1 fI,ies

N

Figure 6: Accuracy Assessment and Ground Validation Points. Collect by the National Park of
American Samoa and others. The attributes for each point may be used to confirm the classified BPI
zones and structures.
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however, a great number of them include benthic zones, habitats, comments about marine

life seen at the site, and geographic locations. These data will be used to groundtruth the

BPI zones and structures where the bathymetry overlaps the shallow water regions and to

associate marine life with each area.

6.3.3. Other Surveying Methods: Valuable, but Limited

In March 2002, a mission led by Sylvia Earle, founder of the Sustainable Seas

Expedition (SSE), followed up the 2001 surveys. This SSE mission resulted in 60

SCUBA dives at the sanctuary and other sites around Tutuila. The divers collected

several underwater videos and photos documenting 3 0-50 species of corals, four shark

species, more than 200 fish species, and 20 invertebrate species. Unfortunately, these

data were not georeferenced, so they are not useful for classifications. They contributed

mostly to public outreach.

Conventional SCUBA diving, underwater photography, videography and

rebreather diving are some of the in situ visual survey methods that are valuable to

benthic habitat mapping. Conventional SCUBA is limited to about 30 m, the maximum

safety depth. Dive limits hinder the extent of underwater photography and videography.

Rebreather divers, with mixed-gas diving equipment, reuse oxygen left unused in

each exhaled breath with closed or semi-closed circuits. Rebreather diving extends the

dive time and the maximum depth of the dive, about 150 m (Pyle 2001). This is a

valuable process, but it is tedious and expensive in large study areas. After the 2001

multibeam mapping survey, two slender peninsulas were noted in Fagatele Bay, and
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rebreather divers explored one of them (Wright et al. 2002). The bathymetric maps

guided the deep diving rebreather mission in May 2001 by Richard Pyle of the University

of Hawaii. Divers on that mission collected digital video of biological habitats and

physical features below 30 m depth. The videos captured footage of geological features

and marine life down to 113 m depth with a Sony VX-1000 video camera (Pyle 2001;

Wright 2002). During a single dive, Pyle identified 12 new species and approximately 18

more that previously had not been seen in American Samoa (Pyle 2001; Wright 2002).

Submersible dives are one of the limited resources for viewing deep water benthic

habitats. Submersibles are manned, underwater vehicles that can explore transects in

excess of 150 m. Deeper than about 150 m, submersibles are the best resource. They are

extremely expensive to operate, so they generally are used to explore the abyssal

environments (Pyle 2001). The area between 30 m and 150 m is often left unexplored, so

virtually nothing is known of the shelf-edge coral reef habitat world-wide.

Many visual surveying methods exist and are regularly practiced; such methods

can provide a visual assessment of the zone between 30 m and 150 m, but the surveys

result in limited coverage. Detailed classifications depend on the availability of data and

the accuracy and scale of the data. Lack of access to groundtruthing for accuracy

assessment limits the results. Accuracy depends on the survey equipment used,

subjectivity and expertise of visual data collection and interpretation. All of these factors

allowed a limited level of classifications around American Samoa. However, the

classifications that were developed and applied in this study are valuable to continued

research in that area with the addition of further visual survey data.
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7. Development of Classification Scheme for American Samoa

This study uses the extensive multibeam bathymetry coverage around American

Samoa to analyze and classify BPI zones, structures and rugosity for depths that can not

be efficiently reached by other surveying methods. The methods developed here and

applied to American Samoa sites are the first to successfully create a benthic

classification for multibeam bathymetry beyond 30 meters depth that extends existing

shallow water benthic classifications (Appendix A). Spatial analysis was used to derive

slope and multiple scales of bathymetric position from the original bathymetry. The

resulting derivative grids were combined with a new algorithm to develop final products:

BPI zones, structures and rugosity classification maps for each study site. The maps

make use of a new classification scheme that may be extended to other coral reef

systems. The mapping methods and criteria for classifying benthic zones, including the

classification scheme, are summarized in the flowchart in Figure 7. The development

and application of the methods are discussed in more detail in the Data Analysis section.

The classification methods identify four BPI zones: crests, depressions, fiats, and

slopes. They further classify thirteen structure classes: narrow depression, local

depression on flat, lateral midsiope depression, depression on crest, broad depression

with an open bottom, broad fiat, shelf, open slopes, local crest in depression, local crest

on flat, lateral midsiope crest, narrow crest, and steep slope.
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Figure 7: Flowchart of Classification Methods. This represents methods for classifying BPI zones
and structures around American Samoa. The data sets portrayed here are a small region
representative of the data set at each study site. The original bathymetry is used to derive
bathymetric position index (BPI) and slope. The derivatives are combined with the original
bathymetry in an algorithm to produce benthic maps. The zones and structures are listed with colors
that match the legends used in the resulting maps (Appendices H and I).
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Multiple classification schemes were considered for benthic classifications around

American Samoa. The NOAA/NOS Biogeography Program developed the first

classification scheme for U.S. Pacific Islands. Their hierarchical scheme is well suited

for classifying shallow water benthic zones and habitats from Ikonos imagery such as in

the Northwest Hawaiian Islands. In agreement with the NOAA Mapping Implementation

Plan (2003), the scheme needs modification for deeper water benthic classifications.

Weiss's (2001) terrestrial landform classes are another valuable classification scheme.

Weiss's study classifies slope position and landform types that are predictors of habitat

suitability, community composition, and species distribution. In this study, the landform

classes are a description of the seafloor that can be used as a baseline for future habitat

studies. The terminology used in the classification scheme presented here is well-matched

with the NOAA/NOS Biogeography scheme for shallow water classifications around the

Main Hawaiian Islands (NOAA: NWHI 2003). Their scheme, in combination with a

scheme being developed at the CRED (Rooney and Miller pers. comm. 2004), the Weiss

(2001) landform scheme, and the Speight (1990) scheme, was closely analyzed to

develop agreeable terms for the BPI zones and structures that extend below 30 meters

depth around American Samoa.

In this scheme, the term broad refers to seafloor characteristics that were defined

by broad scale bathymetric position index (BPI) grids. The termjine refers to seafloor

characteristics that were defined by fine scale BPI grids. BPI is described in more detail

in the section 8.1.
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7.1. Classification Scheme for BPI Zones

A surficial characteristic of the seafloor based on a bathymetric position index

value range at a broad scale and slope values.

1, Crests

High points in the terrain where there are positive bathymetric position
index values greater than one standard deviation from the mean in the
positive direction

2. Depressions

Low points in the terrain where there are negative bathymetric position
index values greater than one standard deviation from the mean in the
negative direction

3. Flats

Flat points in the terrain where there are near zero bathymetric position
index values that are within one standard deviation of the mean. Flats have
a slope that is <= 5.

4. Slopes

Sloping points in the terrain where there are near zero bathymetric position
index values that are within one standard deviation of the mean. Slopes
have a slope that is> 5. Slopes are otherwise called escarpments in the
Main Hawaiian Islands classification scheme.

7.2. Classification Scheme for Structures

A surficial characteristic of the seafloor based on a bathymetric position index

value range at a combined fine scale and broad scale, slope values and depth
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1. Narrow depression

A depression where both fine and broad features within the terrain are lower
than their surroundings

2. Local depression on flat

A fine scale depression within a broader flat terrain

3. Lateral midsiope depression

A fine scale depression that laterally incises a slope

4. Depression on crest

A fine scale depression within a crested terrain

5. Broad depression with an open bottom

A broad scale depression with a U-shape where the nested, fine scale
features are flat or have constant slope

6. Broad flat

A broad flat area where the terrain contains few, nested, fine scale features

7. Shelf

A broad flat area where the terrain contains few, nested, fine scale features.
A shelf is shallower than 22 meters depth. (This depth value was decided
on based on 3D visualization and the Northwest Hawaiian Islands (NWHI)
classification scheme (NOAA: NWHI 2003). The NWHI scheme defines a
shelf as ending between 20 and 30 meters depth.)

8. Open slopes

A constant slope where the slope values are between 5 and 70 and there are
few, nested, fine scale features within the broader terrain.

9. Local crest in depression

A fine scale crest within a depressed terrain
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10. Local crest on flat

A fine scale crest within a broader flat terrain

11. Lateral midsiope crest

A fine scale crest that laterally divides a slope. This often looks like a ledge
in the middle of a slope

12. Narrow crest

A crest where both fine and broad features within the terrain are higher than
their surroundings

13. Steep slope

An open slope with a slope value greater than 70

8. Data Analysis

8.1. Bathymetry, Slope, and Bathymetric Position Index

Bathymetry was received for analysis, after post-processing, as a 3-column XYZ

ASCII file with positive depth values based on a mean low low water datum. For

Fagatele Bay, Coconut Point and Taema (Eastern), the XYZ bathymetry was gridded at

im grid spacing with the mbgrid command in MB-System (Caress et al. 1996) (Appendix

B). MB-System outputs grids in the format of Generic Mapping Tools (GMT) for a

UNIX environment (Wright et al., 2002). GMT is a public suite of tools used to

manipulate tabular, time-series, and gridded data sets, and to display these data in

appropriate formats for data analysis (Wessel and Smith 1991). Then the GMT grids

were converted to a format compatible with Arc/INFO® using a suite of tools called
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ArcGMT (Wright et al., 1998). For Taema Bank (Western), the XYZ data were gridded

with Fledermaus and exported as an ArcView ASCII file. The ASCII file was converted

to a grid with ArcToolbox. After importing the grids into the Arc/INFO® raster grid

format, algorithms were run in ArcGISTM to calculate first- and second-order derivatives

of the bathymetry. The derivatives used in this project for describing seafloor

characteristics with bathymetry are slope and bathymetric position index.

Slope, or the measure of steepness, is simply derived with Surface Analyst in

ArcGISTM. Output slope values (raster grids) are derived for each cell as the maximum

rate of change from the cell to its neighbor. BPI measures where a georeferenced

location, with a defined elevation, is relative to the overall landscape by evaluating

elevation differences between a focal point and the mean elevation of the surrounding

cells within a user defined rectangle, annulus, or circle. Resulting place locations include

hilltops, valley bottoms, slopes, exposed ridges, flat plains, and other features (lampietro

and Kvitek 2002). BPI is a second-order derivative of bathymetry modified from

topographic position index as defined in Weiss (2001) and lampietro and Kvitek (2002).

To apply the algorithms used by Weiss (2001) to bathymetric data, some changes were

made. Modifications include the use of negative bathymetry, different standard deviation

ranges, and different slope ranges. Also, the algorithms suited for bathymetry have a

distinct designation of depth ranges.

The cells in the output grid are assigned values within a range of positive and

negative numbers (Figure 8). A negative value represents a cell that is lower than its
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neighboring cells. A positive value represents a cell that is higher than its neighboring

cells. Valleys appear as negative values while the ridges appear as positive values. More

extreme numbers represent more extreme benthic features. Flat areas or areas with a

constant slope produce near-zero values. The results of BPI are scale dependent;

different scales may be used to identify fine or broad features on the seascape.

Furthermore, conclusions about the structure of the overall seascape can be made with

spatial analysis by applying an algorithm that combines grids of different scales with

slope and bathymetry.
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Figure 8: Bathymetric Position Index (BPI). This image portrays topographic position index (TPI)
(Weiss 2001) which was used to develop BPI for this study. BPI is > 0 where crests (TPI ridges) exist
and <0 where depressions (TPI valleys) exist. Positions that have a constant or near zero slope are
-0. BPI uses a set of surrounding cells, defined by the inner radius (irad) and outer radius (orad) of
a rectangle, annulus, or circle, to assign a value to each cell in an output grid. (Figure, Weiss 2001)
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8.2. BPI Zone and Structure Classifications

After converting positive depth values to negative values, the slope and BPJ grids

were derived. Slope was derived from the high resolution bathymetry using the

ArcGISTM Spatial Analyst Extension's surface analysis. Bathymetry was then resampled

with a reduced resolution (3 m) to reduce the processing time by nine times for the broad

scale BPI grids. For example, for a data set that is 2656 1 m pixels by 3696 1 m pixels,

the time was reduced from over 6 hours to 50 minutes. The bathymetry was regridded

from its raw ASCII form, XYZ, to a GMT grid with the mbgrid command in MB-System.

To achieve the best BPT zone and structure classifications several large and small-

scale grids were created for each study site. The fine scale grids were created with

scalefactors of 10, 20, and 30, and the broad scale grids were created with scalefactors of

50, 70, 125, and 250. BPI<20> and BPI<250> were used to classify Fagatele Bay and

Taema Bank. These scalefactors were chosen because, at these sites, the smallest

seascape features (distance between relatively small ridges) are, on average, about 20

meters across; the largest seascape features (e.g. the distance across the deep channel on

the west end of Taema Bank and the length of the peninsula in Fagatele Bay) are about

250 meters across. For Coconut Point, features of interest were identified from about 10

m to 70 m across, so BPI<1 0> and BPI<70> were used.

BPI was calculated in the ArcGISTM raster calculator using a focal mean

calculation where a cell's elevation is compared to surrounding cells within a user

defined area; the resulting grid values are converted to integers to minimize the storage

size of the grid and to simplify symbolization (Algorithm 1).
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Algorithm 1 creates a BPI grid using bathymetry and user defined radii:

scalefactor = outer radius in map units * bathymetric data resolution
irad = inner radius of annulus in cells
orad = outer radius of annulus in cells
bathy = bathymetric grid

BPJ<scalefactor> = int((bathy - focal mean(bathy, annulus, irad, orad)) + .5)

Prior to the classification of the final zones, BPI was standardized by subtracting

the mean value and dividing by the standard deviation; the result is multiplied by 100 and

then values are converted to integers. (Algorithm 2).

Algorithm 2 standardizes the BPI grids:

BPI<scalefactor>stdi = int((((BPI<scalefactor> - mean)! stdv)* 100) +0.05)

The final algorithms for classifying BPI zones and structures are based on

combined broad scale and fine scale standardized BPI grids, slope, and depth (Appendix

C). In Arc/INFO® GRID, each of the 13 BPI zones received a unique number. The

algorithm uses standard deviation units where 1 standard deviation is 100 grid value

units; slope and depth values are defined by the user (Algorithms 3 and 4).

Algorithm 3 creates one output grid classified by BPI zones by combining the

attributes of BPI and slope:



B-BPI = broad scale BPI grid
out zones = name of the output grid
slope = the slope grid derived from bathymetry
gentle = the user defined slope value indicating a gentle slope

if (B-BPJ > 100) out_zones = 1

else if (B-BPI <= -100) out_zones = 2

else if (B-BPI> -100 and B-BPJ < 100 and slope <= gentle) out_zones = 3

else if(B-BPI> -100 and B-BPI< 100 and slope> gentle) out_zones = 4

endif

The unique numbers assigned to classes in algorithm 3 are the following, as defined in

section 7.1: (1) Crests, (2) Depressions, (3) Flats, and (4) Slopes.

Algorithm 4 creates another output grid classified by structures that are found within each

BPI zone by combining attributes of BPI at multiple scales, slope and depth:

B-BPI = broad scale BPI grid
F-BPI = fine scale BPI grid
out zones = name of the output grid
slope = the slope grid derived from bathymetry
gentle = the user defined slope value indicating a gentle slope
bathy = the high-resolution bathymetry grid
shallow = the user defined depth that separates the shelf from other broad flats
extreme = the user defined slope value indicative of an extreme slope
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if (F-BPI <= -100 and B-BPI <= -100) out structures = 1

else if (F-BPI <= -100 and B-BPI> -100 and B-BPI < 100 and slope <= gentle)
out structures = 2

else if (F-BPI <= -100 and B-BPJ> -100 and B-BPJ < 100 and slope > gentle)
out structures = 3

else if (F-BPI <= -100 and B-BPJ >= 100) out structures = 4

else if (F-BPI> -100 and F-BPJ < 100 and B-BPI <= -100) out structures = 5

else if (F-BPI> -100 and F-BPI < 100 and B-BPI> -100 and slope <= gentle and bathy
<= shallow) out structures = 6

else if (F-BPI> -100 and F-BPI < 100 and B-BPI> -100 and slope <= gentle and bathy
> shallow) out structures = 7

else if (F-BPI> -100 and F-BPI < 100 and B-BPI> -100 and slope > gentle and slope <
extreme) out structures = 8

else if (F-BPI >= 100 and B-BPJ <= -100) out_structures = 9

else if (F-BPI >= 100 and B-BPI> -100 and B-BPI < 100 and slope <= gentle)
out_structures = 10

else if (F-BPI >= 100 and B-BPI> -100 and B-BPI < 100 and slope > gentle)
out structures = 11

else if (F-BPJ >= 100 and B-BPI >= 100) out_structures = 12

else if (F-BPI> -100 and F-BPI < 100 and B-BPI> -100 and slope > extreme)
out structures = 13

endif

The unique numbers assigned to classes in algorithm 3 are the following, as

defined in section 7.2: (1) Narrow depression, (2) Local depression on flat, (3) Lateral

midsiope depression, (4) Depression on crest, (5) Broad depression with an open bottom,
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(6) Broad flat, (7) Shelf, (8) Open slopes, (9) Local crest in depression, (10) Local crest

on fiat, (11) Lateral midsiope crest, (12) Narrow crest, and (13) Steep slope.

Specific values for slope and depth are sensitive to interpretation at specific study

sites. Each study site has a unique composition of depth and slope ranges. The methods

are best applied where slope and depth values are considered on the condition of

transition zone locations and the presence of two or more significant depth ranges within

the study site. In order to develop a uniform classification for all the American Samoa

study sites, common values that are suitable for sites around Tutuila were used in the

classification algorithms (Appendix D). These slopes and depths were determined using

3D visualization.

8.3. 3D Visualization

The bathymetry was analyzed with Fledermaus software for 3D scientific

visualizations and analysis (Interactive Visualization System, IVS, www.ivs.unb .ca)

(Appendix E). Unlike other visualization product developers, IVS initially designed this

suite of tools specifically to handle high-resolution digital bathymetric data. IVS

provides an environment that is fully capable of interactive 3D analysis and exploration.

The software is capable of handling very large (lOs to 1 OOs of megabytes) georeferenced

data sets (Mayer et al. 2000). An important feature of the DMagic module within

Fledermaus is the ability to drape colored images and/or terrain data over bathymetry.

For example, this project used DMagic to combine bathymetry with a slope grid using the

bathymetry's color scheme. The addition of the slope values to the analysis allowed the
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depth and slope values to be displayed in the 3D scene and related to each other for the

spatial analysis that created the BPJ zones and structures (algorithms 3 and 4). ArcGMT®

was used to convert the Arc/INFO® format grids to Generic Mapping Tool (GMT) grids

and they were added to the visualization.

Interactive features such as the addition of scalar values and profile analyses were

used to assess the accuracy of BPI zones and structures. Scalar values appear as a fourth

dimensional value as the user moves the cursor across the seascape. In this study, slope

values, zone, and structure classifications appeared as scalar values along with the default

values that Fledermaus displays: latitude, longitude and depth. The slope values were

viewed as the scalar to determine the values used in the spatial analysis. When colored

benthic zones and structures were draped over the bathymetry, the position and accuracy

of the zones and structures were readily seen in an interactive profile view. A line drawn

across the 3D view opens a separate view that displays the profile of the seascape along

that line. The 3D profile analysis was used to verify each structure class (Appendix F).

8.4. Rugosity Analysis

The resulting benthic maps will serve as a baseline for more detailed habitat

classifications. The zones are an excellent broad portrayal of the seafloor; however, they

do not describe the types of substrates or the complexity of the seascape. Since the

shallow water classifications around American Samoa use a hierarchical classification

scheme, it is desirable to develop methods that can extend the classification at a finer

scale within BPI zones. To get a detailed classification of BPI zones and structures,
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rugosity analysis gives a picture of seafloor complexity. The rugosity analysis results in

descriptive benthic rugosity maps that will help pin point areas with potentially high

biodiversity (Appendix G).

Rugosity, a second-order derivative of bathymetry, is a good measure of benthic

complexity. Rugosity describes topographic roughness or bumpiness with a ratio of

surface area to planar area. Rugosity was derived with the ArcView® Surface Area from

Elevation Grids extension (Jenness 2003) in combination with Spatial Analyst. The

algorithm uses a 3x3 neighborhood analysis to calculate surface area based on a 3D

interpretation of cells' individual elevations (Figure 9). Rugosity values near one
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Figure 9: Rugosity Derivation. Rugosity is the measure of roughness or bumpiness. Rugosity is
derived with an algorithm that finds a ratio of surface area to planar area. The algorithm uses (a) a
3x3 neighborhood comparison to calculate (c) surface area based on (b) a 3D interpretation of the
cells' individual elevations. (Jenness 2003)

indicate flat, smooth locations and higher values indicate areas with high-relief. Rugosity

was classified by extending the classes used by CRED in their 2002 towed-diver surveys.

The classes were assigned with standard deviation divisions in ArcView® 3.3. The

following divisions were used for each study site: Very High (>3 std. dev.), High (2 3

std. dev.), Medium High (1 2 std. dev.), Medium (0 1 std. dev.), Medium Low
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(Mean), Low (-1 0 std. dcv.). Fagatele Bay has a large range of rugosity values from 1

to 44. 44 is indicative of an extreme surface ratio. It is the case for Fagatele Bay because

of the steep slopes in the middle of the bay where the change in elevation from one cell to

another is greater than 40. Rugosity can be associated with the attributes recorded during

the dives and also with the comments and attributes that were recorded in accuracy

assessment surveys conducted in 2001.

9. Application of Classifications to Sites around American Samoa

The classifications of BPI zones (Appendix H) and structures (Appendix I)

developed for American Samoa were extended to include rugosity classifications

(Appendix G). Once the methods have been tested on further sites, they will be used

regionally to hasten the process of deep water coral reef ecosystem mapping. The

following descriptions of the study sites are a significant step in creating baseline data for

the South Pacific region. They are a proof of concept where the methods have been used

to successfully classify BPI zones and structures in priority reef systems around

American Samoa.

9.1. Fagatele Bay National Marine Sanctuary (Appendix Figures G.1, 11.1, 1.1)

Fagatele Bay National Marine Sanctuary is a complex environment. The

submerged caldera dramatically slopes downward toward its center of what is now a

submerged caldera from all of its shoreward locations. There is a large fringing reef in



the northwest corner of the bay that was largely classified with Ikonos imagery by the

NOAA/NOS Biogeography Program. Bathymetry overlaps the Ikonos classifications

from about 3 m to 30 m (Appendix A). That overlapped area is mostly flats and some

slopes. The edges of the study site indicate the presence of some speckled flats and some

distinctly raised crests. Toward the center of the bay, distinct depressions occupy the

deepest parts of the bay.

Around 22 m the shelf quickly becomes open slopes that descend toward the

broad depressions with open bottoms in the bottom of the bay. Historical surveys have

noted a submerged barrier island through the middle of the bay. The open slopes above

and on the edge of the narrow depressions in the center of the bay suggest that this could

be the site where the seafloor has subsided to break apart the submerged barrier island

since it was noted in the 1920s (Mayer 1924). The peninsula near the center of the bay is,

indeed, noteworthy. This peninsula is the site where rebreather divers identified 12 new

species and observed many others (Pyle 2001). It is classified as a narrow crest with

fringing lateral midsiope crests and then depressions. The edge of the peninsula falls so

quickly in some place that there is a narrow strand of steep slopes around it. Steep slopes

are also seen at the edge of other narrow crests and lateral midsiope features throughout

the bay. The area that appears most complex, containing a diverse combination of BPI

zones, is in the southeast part of the bay that extends toward the Matautuloa Benchmark.

Several points were visually surveyed in Fagatele Bay; however all of the points

are assessments in less than 30 meters depth. Thirty-four points overlap the bathymetry
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for this study site. They provide a good accuracy assessment for the BPI zones and

structures that were quantified in this study.

They also provide attributes about many shallow locations throughout the bay.

Most of the points are attributed with compositions of Acropora, Pocillopora, Millapora

and other encrusting and branching corals. Most of the points are noted to be colonized

pavement and some are composed of basalt and boulders. On the open slopes where flats

are scattered, the point attributes note patches of sand and rock with some coral or rubble.

On the open slopes without other fine features, points are generally noted as sand

although some had recorded observations of some Acropora. Some places that were

classified as lateral midsiope crests within open slopes were noted with point attributes as

being flat basalt shelf. Perhaps those crests are on slopes that have slope values near but

greater than 5. The accuracy assessment points all fall within the bank/shelf and

escarpment zones as classified previously by the NOAAINOS Biogeography program

with Ikonos imagery (NOAA: Projects 2003). These correspond 100% with the shelf and

open slope structures that are classified in this study. For example, a point on a classified

shelf about 35 meters shoreward of a steep slope is attributed as such: Zone, Bank/Shelf;

Comments, flat carbonate encrusted basalt ledge 50 ft shoreward of the vertical ledge

dropping off deeply.

Another benefit of applying the classifications to Fagatele Bay is the existence of

towed-diver videos. The videos were analyzed, and the survey transects were attributed

with a subjective level of habitat complexity and approximate percentages of coral, algae,

sand, and rock. Some specific species were also noted by the divers. With the



classifications used in this study and the lack of detailed backscatter imagery, a fair

comparison of the towed diver transect in Fagatele Bay was not conducted. The transects

were qualitatively compared to the rugosity grids developed at this site, and perhaps

because of the subjective interpretation of the videos or because of the scale at which the

data were analyzed, the two data sources did not consistently match (Figure 10).
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Figure 10: Fagatele Bay, Classified Rugosity vs. Segmented Towed Diver Complexity. This is a
screen capture of ArcMap displaying Fagatele Bay. The semi-transparent rugosity grid is overlaying
a bathymetric semi-transparent hillshade. This reveals rugosity in association with complexity and
depth. Dark blue areas have very high rugosity and yellow areas have low rugosity. The towed diver
survey transect is symbolized with attributes of habitat complexity.
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One area where they did match was an area of great complexity where the towed

diver survey transect was attributed with high complexity and the rugosity analysis

indicates a broad area of high and very high rugosity. This occurs in the complex

southeast portion of the bay, as previously mentioned, across a vertical wall.

Where segments are attributed with medium complexity, the derived rugosity is

mostly medium and low. Additionally, the section attributed as medium low is mostly

low in the rugosity grid. These medium and medium low segments may have received

such classifications because the majority of the segment is in the respective class. It

possibly would have been more effective to make smaller segments. For example, the

medium segment that is the furthest west in the bay could have been two segments where

one is in fact medium while the other section is medium low. In the segment attributed

with medium low, there is actually a section that crosses an open slope that is classified

as medium in the derived rugosity. This area could easily be noted by a diver as medium

low if the slope is very gradual across the segment while the quantified rugosity would

account for the fine features that make it more complex. The medium high segment may

have been attributed as such because, although there does not seem to be great vertical

relief, the segment crosses many small parallel features with higher rugosity.

Without a common method for attributing visual data and derived grids, the two

can not be quantitatively compared. The rugosity and complexity classifications differ

too much between the towed diver observations and the rugosity grid. However, by

identifying the habitat types assigned to the towed diver survey segments, one may get an

idea of where marine life is located. The highly complex segment in the southeastern
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part of the bay is attributed as a vertical wall without suitable visibility to identify habitat

types. The segments in the part of the bay situated in the shallower areas that reach

toward the reef flat are attributed with 50% or more live coral. As the segments move out

of the inner bay toward the open sea, the segments have less live coral. The segments in

the western part of the bay and the most southern segment still have some live coral, but

50% or more of the coral there is dead. Algae is found across all the segments from 15%

to 40% except for the segment attributed with high complexity just south of the segment

across the vertical wall; there is 55% algae within that segment. Sand is only attributed

from 0% to 10% in all segments.

9.2. Coconut Point (Appendix Figures G.2, 11.2,1.2)

At Coconut Point, the seafloor is most flats and slopes. The western edge of the

study site is continuous crest revealing flanks of the shelf just east of the international

airport. Moving east, slopes lead into flats and the transition between the two are

occasionally depressed zones. An almost continuous crest divides the flats and lead into

solid slopes down to a deeper level of broad flats and slopes with a few broad depressed

areas. The southern portion of this site is made up of alternating fine flats and slopes that

form a pattern that looks like spur and groove coral.

The structures within the zones at Coconut point show more detail in the terrain.

The southern alternating flats and slopes are broken into shelf and open slopes with

lateral midsiope crests and depressions. The western edge of crests is seen as a narrow

crest with lateral midsiope depression, local depressions on flats, and some shelf areas
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and open slopes interspersed. The narrow crest leading north from the portion that looks

like spur and groove coral is outlined on the north side by a steep slope and then lateral

midslope depressions and crests that indicate a rapid drop onto the deeper open slopes.

The suggestion that spur and groove coral exists on the shelf at Coconut Point

may be confirmed with visual survey data. The accuracy assessment surveys performed

by the National Park of American Samoa covered the entire nearby Pala Lagoon, but the

survey reaching the portion of the study site used in this study only included six points.

Four of the points indicate colonized pavement. The surveyors suggest that there are spur

and groove structures at the same points with sand in some of the grooves. The other two

points are attributed as sand or 50% to 90% continuous coralline algae. Among the six

points there is anywhere from 5% to 85% coral.

9.3. Taema Bank (Eastern) (Appendix Figures G.3, H.3, 1.3)

Taema Bank is made up of mostly flats and slopes, but there are very distinct

crests and depressions across the study site. The seafloor features are more discernable

when the zones are broken into structures. The shelf and broad flats are surrounded by

open slopes. Where the shelf reaches a kind of escarpment reaching toward the broad

flats, there is a series of almost parallel lateral midslope depressions and crests that look

like large spurs and grooves. The open slopes lead down to broad depressions with open

bottoms on both sides of Taema Bank. Two significant features on this part of Taema

Bank are the broad depression with an open bottom centered at about 14°18'15"S,

170°38'W and the narrow crest at about 14°18'27"S, 170°39'30"W. The broad



52

depression's length and open ends shows that it is a channel where the bank drops into

narrow depressions with some local crests and depressions leading into the open bottom

of the broad depression.

The narrow crest on the portion of the grid reaching north toward Pago Pago

Harbor can be viewed as a pinnacle based on its round shape. It is surrounded by open

slopes and has some depressions dispersed across the crest. This pinnacle site is a great

example of how certain benthic features are better understood by viewing them in three

dimensions. The height of the pinnacle is unknown when viewing the zones in two

dimensions. The site is actually one pinnacle with two peaks reaching about 17 m depth

in the middle of open slopes that lead to a broad depression with an open bottom reaching

a depth of about 95 m (Figure 11).

Figure 11: Crest near Taema Bank - A 3D Visualization. This is a screen capture of a 3D crest in
iView3D, a free viewer for scientific data compiled in the DMagic module of Fledermaus. The view is
shaded with bathymetry where pink is shallow and green is deep. The crest is located shoreward of
Taema Bank. It has 2 peaks and reaches from about 17 m to 95 m depth.
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The broad depression with an open bottom has scattered local crests in it. The

scattered local crests may be some patch reef in the depressed zone. Up on the broad flat

and open slopes, more scattered lateral midslope features may also indicate areas of patch

reefs. These inferences may be confirmed with visual observations. Unfortunately, the

visual surveys that have been conducted around Tutuila have only included five

observational surveys across Taema Bank. From the few points that were attributed a

general idea of the local substrates that occur from the shelf to the broad flats can be

observed. The shelf contains points where there is colonized pavement covered by a

veneer of sand. Within the fringing lateral midslope depressions and crests on the open

slopes, surveyors also observed colonized pavement and a hummocky bottom with low

relief and -5% sand with some table Acropora, digitate, and encrusting coral. The one

point on the broad flat attributes sand with sand covered pavement 2O m from the point.

9.4. Taema Bank (Western) (Appendix Figures G.4, H.4, 1.4)

This portion of Taerna Bank is cresting across the length of the shallowest part of

the bank. The crest is fringed by slopes leading to broad flats that have smaller crests and

slopes interspersed. The Northeast part of the site overlaps Taema Bank (Eastern), again

giving a good picture of the broad depression with an open bottom centered at about

14°18'15"S, 170°38'W. The feature is surrounded by slopes that lead to the bottom. The

far reaches of the bank are depressions that reach the edge of the grid. There is a

continuing pattern of spur and groove features across the cresting top of the bank. These

features are classified as a series of narrow crests, lateral midsiope depressions and lateral
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midsiope crests. The crests across the flat BPI zones, by their shape, may be pinnacles.

The structures that form the so called pinnacles are classified as lateral midsiope features

and narrow crests all surrounded by a narrow ring of open slopes.

When the rugosity grid is added to this visual analysis, one can pick out the

pinnacles and other features that may be pinpointed as being more complex (Figure 12).

Some of the pinnacles with steeper surrounding slopes are highlighted as having a higher

rugosity. Also, the structures classified as broad depressions with open slopes on the

edge of the grid indicate an area with higher rugosity. Another area of interest for further

surveys may by the fringing parts of the top of the bank, where the spur and groove

features are surrounded by open slopes. A towed diver surveyed along a transect that

laterally crosses the top of the bank. This portion was segmented and attributed with

habitat complexity values of medium and medium high. The rugosity grid is classified as

low surface area for the whole transect. The subjectivity of the diver notes should be

considered here. The divers generally look within a smaller area (depending on the range

of visibility) than the area that is covered by the classified rugosity grid. The towed diver

attributes that are medium seem to match the section of the rugosity grid that closely

aligns the survey track (on the fringes of the top of the bank). If the divers considered the

complexity of the nearby spurs and grooves, then the medium high attributes make more

sense. A limitation of rugosity is confirmed by these observations. That limitation is that

the rugosity, or roughness (surface area), does not take into account the complexity of the

roughness of an area.
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Figure 12: Taema Bank, Classified Rugosity vs. Segmented Towed Diver Complexity. This is a
screen capture of ArcMap displaying a portion of Taema Bank. The semi-transparent rugosity grid
is overlaying a bathymetric semi-transparent hillshade. This reveals rugosity in association with
complexity and depth. Dark blue areas have very high rugosity and yellow areas have low rugosity.
The towed diver survey transect is symbolized with attributes of habitat complexity.

Overall, Taema Bank (Western) has several artifacts. The multibeam mapping

tracks are pronounced across the grid and may indicate invalid classes in some places.

Most of the artifacts, likely a result of limitations of real time corrections during the

survey, are on the edges of the swaths and are classified as slopes in the BPI zones grid.

For this reason, and in the case of further surveying, open slopes and many of the narrow,

linear features at this site should be further analyzed.
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10. Distribution of Methods and Data

The data and maps used for this study are all available on the DVD as part of this

thesis. The data analysis techniques from this study fulfill a cooperative agreement

proposed by Oregon State University and will be made available to CSC. CSC is

supporting this study, not only by funding it, but as part of their Integration and

Development initiative by creating a benthic habitat mapping tool. The tool, an extension

for ArcGISTM 8.x, will have a user-friendly interface similar to Arc View®'s

Geoprocessing Wizard. Arc users' familiarity with wizards will make the tool easier to

use. To use the tool, a user simply needs to have a bathymetry raster data set. The tool

will classify BPT zones, structures and rugosity. Among the users' options is a default

classification scheme and a section to customize their own scheme with user defined

slope and depth values. Separate output grids will be exportable, allowing the user to

create a layer for each classification that can be used in combination with additional,

study-specific data for benthic habitat mapping. The use of the tool is further described

by Rinehart et al. (2004). In an effort to introduce the techniques and data to managers,

researchers, and other users, Larkin (in progress) is creating educational modules that will

supplement an internet map service. These tools will be field tested in September 2004 in

American Samoa (AS) at the AS Community College and possibly other sites on Tutuila.

Participants include stakeholders in the management of marine and coastal resources

around American Samoa: college students, resource managers, and other interested



parties. They will be introduced to and able to work with marine GIS and benthic

classifications using local data from sites they are likely very familiar with.

The FBNMS GIS Data Archive is hosted at Oregon State University, serving as a

data clearinghouse for Fagatele Bay National Marine Sanctuary and other study sites in

American Samoa (dusk.geo.orst.eduldjl/samoa). Base layers and raster grids such as

shoreline and watershed boundaries, coastlines, contours, digital raster graphics, villages,

vegetation, soils, topography and bathymetry are available for download. Users may

view each data set as a thumbnail before downloading it. The website includes FGDC

standard metadata for each data set. Upon project completion, the FBNMS GIS Data

Archive will include maps, data and metadata developed in this study: bathymetry, BPI

zones, structures, rugosity, BPI, aspect, and slope grids for each study site.

11. Discussion

The approach taken in this study will allow users of the resulting data and maps to

apply them in a way that is most appropriate for their needs. The separate data sets may

be used in an integrated GIS in many different combinations. They may be analyzed and

combined differently for each study. For example, researchers at CSUMB have used a

combination of similar data to target areas where rockfish are likely to be found

(Tampietro, pers. comm. 2004). Since habitats for individual species are so specific and

discrete, the availability of data sets that may be arranged as layers in a GIS allows a

broad audience to use the resulting methods and data.
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Within the structure classes, there may still be a need for more descriptive classes

that give a better idea of the shape of a seafloor structure. The algorithm for structure

classifications could be enhanced with more variables such as variance, relief, and length

to understand which depressions are channels and which are circular or irregularly

shaped, and to understand which crests are actually ridges or pinnacles.

The BPI zone and structure classes successfully extend the existing shallow water

classifications from Ikonos satellite imagery. Researchers have effectively used LIDAR

light detection and ranging and Ikonos satellite imagery for shallow water habitat

mapping (Brown et al 2002; Gamon and Heummrich 2002). Energy from these sensors

is attenuated in water, and thus habitats can only be accurately classified to a depth of

rn in clear waters. For example, the shallow water (<30 m) berithic habitats for

American Samoa were classified and mapped by the NOAAINOS Biogeography Program

using high-resolution (1- and 4 m) Ikonos imagery obtained through the CRTF initiative

(NOAA: Projects 2003). The NOAA/NOS Biogeography Program's Ikonos

classifications are overlapped and extended by the classifications derived from multibeam

bathymetry for areas below 30 m depth around American Samoa. They can easily be

viewed with an integrated GIS to make comparisons between the Ikonos classifications

and the classifications developed in this study; the two classifications overlap each other

from about 3 rn to about 30 m depth (Figure 13). The Ikonos classifications were quite
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Figure 13: Coconut Point Structures vs. Ikonos Zone Classification. This is a screen capture of a
GIS for a classification of Coconut Point structures. The structures overlap the Ikonos zone
classifications from about 3 m to 30 m. A few points where they overlap are identified with the
points' classifications from both methods. They match very well, but the comparison was not
quantified.

useful where they and the multibeam bathymetry overlap. They provided a standard set

of zones that were expected as results from the classifications in this study. It was

expected that the BPI zones and structures would indicate shelf and escarpment regions



on the shoreward parts of Fagatele Bay and Coconut Point and in the center of Taema

Bank. They do, indeed, indicate such surficial features. The Ikonos imagery was

interpreted and classified by site and digitization, so the results are subjective to the

researcher(s) and the clarity of the satellite imagery. In this case, the Ikonos

classifications successfully indicate the general areas of shelt forereef, escarpment, and

other zones. However, they are generalized because of the subjective nature of satellite

imagery interpretation. The BPI zone and structure classes extend the Ikonos classes

with more detailed features. Where the two overlap, the BPI zones provide a more

detailed boundary for the broader zones and the structures provide a more detailed picture

of the features that lie on those shelves and escarpments.

A large part of creating the classification scheme for BPI zones and structures

around American Samoa was the sorting of terminology. It is important in the marine

and coastal mapping community for multiple researchers and managers from several

related disciplines to understand the meaning of benthic classes. This study used very

basic terminology in order to make the surficial descriptions more robust for researchers,

managers, and others to use effectively in their specialties.

The NOAA Biogeography Program and the NWHI mapping team are anticipating

an applicable regional classification scheme for zones and structures below 30 m depth.

The resulting BPI zones, structures and rugosity classifications for American Samoa

should undergo further testing with other study sites before considering them to be a

regional classification scheme. The classification methods have been applied to three

more sites around Tutuila, American Samoa: National Park of American Samoa,
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Faga'itua Bay, and Vatia Bay. The maps for these study sites have resulted in very

reasonable classifications. The classification scheme will be applied to additional sites

before it is adopted for regional use.

Already, CRED has reviewed draft classifications during preparation for a

mission around American Samoa in February and March of 2004. The mission

conducted sonar surveys, towed diver surveys, and additional visual surveys. There is

now full coverage of high-resolution multibeam bathymetry around the entire south

eastern sides of Tutuila as well as the areas around Ofu and Olosega. Classifications will

be applied to the recently surveyed region from 30 m and down to 200 m depth. In the

ftiture, the classified maps will be useful for identification of spots that need further

analysis and groundtruthing and they will guide future in situ missions.

Fagatele Bay National Marine Sanctuary and the National Park of American

Samoa, along with other members of the AS GIS User Group will use the classified maps

for management. They will make scientific assessments with the resulting GIS data to

potentially designate more marine protected areas in American Samoa. The resulting BPT

zone and structure grids and maps will not only be added to the FBNMS GIS data

archive, but they will be available for queries and other analyses on an ArcIMS site being

developed for the territory. The internet mapping services will be supplemented with

links to (1) the downloadable data and metadata, (2) a mirrored Samoan language site,

and (3) educational modules (Larkin, in progress).
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11.1 Future Work

The future of the results from this study lies in the hands of their users. The data

and maps may guide users in decision making, management, education, and

understanding of the coral reef ecosystems around Tutuila. Oregon State University,

CRED, University of South Florida and the Fagatele Bay National Marine Sanctuary will

continue to conduct research around American Samoa upon the acceptance and funding

of future grants. The multibeam bathymetry and in situ data collected by CRED in

March 2004 is in the post-processing phase. The extended area that the CRED mission

covered will be classified with the methods in this study. During that application, it is

likely that algorithms will be refined to include structure shapes. The methods may also

be applied to multibeam bathymetry from other islands in the South Pacific. The data and

methods will be introduced in American Samoa through the educational modules in

September 2004 (Larkin, in progress). A submersible survey is scheduled in 2005 to

groundtruth the classification maps and to make discrete connections between species

that are found in each habitat type (Wright and Naar 2003).

12. Conclusion

The study was a success in reaching its goals: (1) methods were developed for

benthic mapping and applied to 3 sites around American Samoa, (2) a new classification

scheme was developed for BPI zones (depressions, slopes, flats, crests) and structures
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(finer features within zones) around the study sites, and (3) visual survey information was

associated with the resulting classifications.

Bathymetry, BPI, slope, and rugosity were combined with spatial analysis to

develop methods for creating a classification for deep water (> 30 m) benthic zones and

rugosity around American Samoa. The methods were based on components of studies

that classified shallow water coral reef systems, terrestrial landforms, and other deep

water systems. As American Samoa is an archipelago of mostly submerged volcanoes,

its shoreline is flanked by fringing reefs that plunge into deep water. This dramatic

topography, combined with a tropical climate, creates a complex coral reef ecosystem

that supports thousands of species. The creation of methods in this study is steered by

acquisition of scientific data in the deep-water benthic regions. The large gap of data and

information about coral reefs between 3 0 m and 150 m exists because of the absence of

cost-efficient data acquisition. The most cost-efficient way to collect bathymetry for a

large area is multibeam mapping. Multibeam mapping surveys collect acoustic

bathymetric data that is used to derive the methods in this study. Bathymetric position

index and slope are derived and combined with the original bathymetry to classify the

benthic zones around Tutuila, American Samoa. Rugosity is then derived from

bathymetry to add more detail about the complexity of the study sites. The benthic

mapping methods developed in this study were successfully applied to seven sites around

the island of Tutuila, American Samoa.

In American Samoa, past studies have classified the seafloor with satellite

imagery, which only reach depths of about 30 m, leaving the seafloor largely



unclassified. The methods used for the benthic and rugosity classifications deeper than

30 m around American Samoa extend the classifications that are completed for shallow

waters around the territory. From the shallow water classifications, only the zones, at a

macro habitat level (Greene et al. 1999) were matched and extended for the deep water

sites. The benthic mapping methods may potentially be applied to other study sites

around American Samoa and to coral reef ecosystems across the Pacific and in the

Caribbean. The application of the methods to extend shallow water classifications will be

fairly easy with the use of the Benthic Habitat Mapping Tool that CSC is developing

from the methods used for American Samoa sites.

Maps that emphasize areas with potentially high biodiversity may be produced

from analysis of in situ visual surveys. While the towed diver survey data that exist for

American Samoa to date are not extensive enough to use for rugosity classifications in

water deeper than 30 m, they will be quite effective in future analyses that identify

species associations with the classifications. Marine life will be associated with highly

diverse areas. The classified maps and high biodiversity maps will be used to make

reference maps for biological and ecological surveys. The reference maps will target

places likely to have the highest biodiversity where researchers doing visual surveys may

protect marine life and other valuable marine resources. Additional multibeam and single

beam mapping surveys around the islands can be classified with the same methods. Data

collected in future work may be planned with or based on the benthic maps or used as a

cross reference for quality assurance of the maps.
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Results of this study will be used by the American Samoa GIS User Group,

CRED, CSC and other resource managers. They provide a baseline for understanding

cora' reef ecosystems, and they contribute to meeting the U.S. Coral Reef Task Force's

goal to characterize priority deep water reef systems.
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Appendix B

Gridding American Samoa XYZ Data in MBSystem (from Dawn Wright)

(1) Make sure that positions are in "geographic" coordinates (lat/long in negative decimal
degrees) and depths are positive

(2) Need to know bounding coordinates -

xrnin(longmin)/xmax(longmax)/ymin(latmin)/vmax(latmax)

example for SW Pacific
-13

-174 -167

-15

(3) Grid xyz file in MBSystem: (read about MBSystern by doing "man mbysystem" at
Unix prompt or refer to MBSystem Manual

mbgrid -Idatalist -E10/l0/m -R-1741-1671-15/-13 -Osamoanew -Al -N -Cl -xo.i -v

where "datalist" = a file with one line in it
<filename of xyz file> 0
"0" means that it's an ascii file rather than a binary multibeam format

E = resolution (cell spacing) of grid, 10 m in example above
R = west/east/soutb!north
o output name
A bathymetry values in data are positive
N = grid cells with no data will be set to "NaN" which is what GMT expects
C = clipping factor for spline interpolation to fill in gaps in grid (can experiment with this
- very important)
X = extension factor which helps to smooth outer edges of grid
V = verbose - program tells you what it's doing as it does

(4) So at the end, in this example, it has made a GMT grid called "sarnoanew.grd" and
command file "sarnoanew.cmd" that helps you to make map of it in GMT to see what it
looks like. It's best to look at the .cmd file to see what it's doing and then to run it you can
just type it's name. However, it will create the map in Postscript format (.ps).

(5) And finally, convert the GMT grid to Arc format using my ArcGMT tool (download
ArcGMT from http://dusk.geo.orst.edu/arcgrnt and read README file that comes with
it)
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Use "grdinfo" at command prompt to see properties of your new grid ... for example

grdinfo samoanew.grd
samoanew2. grd: Title: Bathymetry Grid
sarnoanew2. grd: Command:
samoanew2.grd: Remark:

Projection: Geographic
This grid created by program MBGRID
MB-system Version 4.3
Run by user <dawn> on cpu <dusk.geo.orst.edu> at <Sun Apr 22 18:45:36 2001

samoanew.grd
samoanew2.grd: Normal node registation used
sainoanew2.grd: grdfile format # 0
samoanew2.grd: x_min: -174 xmax: -167 x_inc: 0.00925926 units: Longitude nx: 75
7

samoanew2.grd: y_rnin: -15 y_max: -13 y_inc: 0.00904977 units: Latitude fly: 222
sarnoanew2.grd: zmin: -2829.34 zmax: 7745.83 units: Depth (m)
samoanew2.grd: scale_factor: 1 add offset: 0

Then run Arclnfo from the command line and make sure that you are in the same
directory that youtve downloaded ArcGMT in. Run ArcGMT (&run ArcGMT) at the arc
prompt.
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Specific to FAGATELE BAY NATIONAL MARINE SANCTUARY

rnbgrid -Idatalist -El/i/meters -R- 170.775/- 170.7581-14.3751-14.3583 -Ofag_02_1 m.grd
-N -Al -ClO -V

Program mbgrid
Version $Id: mbgrid.c,v 5.5 2002/04/06 02:53:45 caress Exp $
MB-system Version 5.0.betal8

MB GRID Parameters:
List of input files: datalist
Output fileroot: fag 02 im
Input Data Type: Bathymetry
Gridding algorithm: Gaussian Weighted Mean
Grid projection: Geographic
Grid dimensions: 1834 1848
Grid bounds:
Longitude: -170.7750 -170.7580
Latitude: -14.3750 -14.3583

Working grid dimensions: 1834 1848
Working Grid bounds:
Longitude: -170.7750 -170.7580
Latitude: -14.3750 -14.3583

Longitude interval: 0.000009 degrees or 1.000343 m
Latitude interval: 0.000009 degrees or 1.000397 rn
Specified Longitude interval: 1.000000 meters
Specified Latitude interval: 1.000000 meters
Input data bounds:
Longitude: -170.7920 -170.7410
Latitude: -14.3917 -14.3416

Gaussian filter l/e length: 1.000000 grid intervals
Spline interpolation applied with clipping dimension: 10
Spline tension (range 0.0 to infinity): 10000000000.000000
Grid format 3: GMT version 2 grd (netCDF)
NaN values used to flag regions with no data
MBIO parameters:

Ping averaging: I

Longitude flipping: 0
Speed minimum: 0.0 km/hr

5482753 data points processed in fag 02.xyz
5482753 total data points processed

Making raw grid...
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Doing spline interpolation with 549803 data points...

Total number of bins: 3389232
Bins set using data: 549803
Bins set using interpolation: 80588
Bins not set: 2758841
Maximum number of data in a bin: 1463
Minimum value: 1.76 Maximum value: 168.18
Minimum sigma: 0.0000 1 Maximum sigma: 24.93425

Outputting results...

executing mbm_grdplot...
mbm_grdplot -Ifag 02 lm.grd .-G1 -C -D -V -LttFile fag_02_lm.grd - Bathymetry
Grid:Depth (m)"

Program Status:

GMT Version:
Version 3.4.1

Plot Style:
Color Fill
Contours
Horizontal Color Scale

Input Files:
Data GRD File: fag 02 lm.grd
Intensity GRD List File:

Output Files:
Output plot name root: fag_02_lm.grd
Color pallette table: fag_02_lm.grd.cpt
Plotting shellscript: fag_02jm.grd.cmd
Plot file: fag 02 lm.grd.ps

Plot Attributes:
Plot width: 6.5000
Plot height: 6.5500
Page size: a
Page width: 8.5
Page height: 11

Projection: -Jm382.35
Axes annotation: 15c/15c:."FiIe fagO2_lm.grd Bathymetry Grid":
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Orientation:
Number of colors:
Color Pallette:
Colors reversed

Grid Data Attributes:
Longitude mm max:
Latitude mm max:
Data mm max:

portrait
ii

Haxby Colors

-170.7750 -170.7580
-14.3750 -14.3583

11 .762 168.2

Primary Grid Plotting Controls:
Contour control: 5

Color start datum: 0.000000
Color end datum: 175.000000
Color datum interval: 17.500000

Miscellaneous Plotting Controls:
Contour pen attributes: -Wclp

GMT Default Values Reset in Script:
MEASURE UNIT inch
PAPER MEDIA archA+
ANOT FONT Helvetica
LABEL_FONT Helvetica
HEADER_FONT Helvetica
ANOT FONT SIZE 8

LABEL_FONT_SIZE 8

HEADER_FONT_SIZE 10
FRAME_WIDTH 0.075
TICK_LENGTH 0.075
PAGE_ORIENTATION LANDSCAPE
COLOR_BACKGROUND 0/0/0
COLOR_FOREGROUND 255/255/255
COLOR_NAN 2551255/255
DEGREE_FORMAT 3

Plot generation sheliscript <fag_02_1 rn.grd.cmd> created.

Instructions:
Execute <fag_02_1 m. grd.cmd> to generate Postscript plot <fag_02_1 in. grd.ps>.
Executing <fag_02_lm.grd.cmd> also invokes ghostview to view the plot on the screen.

Done.
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Specific to COCONUT POINT

mbgrid -Idatalist -El/i/meters -R- 1 70.704/-170.6875/-14.3375/-14.308 -Ocpt_lm -N -Al
-do-V

Program rnbgrid
Version $Id: mbgrid.c,v 5.5 2002/04/06 02:53:45 caress Exp $
MB-system Version 5.0.betal8

MBGRID Parameters:
List of input files: datalist
Output fileroot: cpt_lm
Input Data Type: Bathymetry
Gridding algorithm: Gaussian Weighted Mean
Grid projection: Geographic
Grid dimensions: 1781 3264
Grid bounds:
Longitude: -170.7040 -170.6875
Latitude: -14.3375 -14.3080

Working grid dimensions: 1781 3264
Working Grid bounds:
Longitude: -170.7040 -170.6875
Latitude: -14.3375 -14.3080

Longitude interval: 0.000009 degrees or 1.000025 m
Latitude interval: 0.000009 degrees or 1.000290 m
Specified Longitude interval: 1.000000 meters
Specified Latitude interval: 1.000000 meters
Input data bounds:
Longitude: -170.7205 -170.6710
Latitude: -14.3670 -14.2785

Gaussian filter l/e length: 1.000000 grid intervals
Spline interpolation applied with clipping dimension: 10
Spline tension (range 0.0 to infinity): 10000000000.000000

Grid format 3: GMT version 2 grd (netCDF)
NaN values used to flag regions with no data
MBIO parameters:
Ping averaging: 1

Longitude flipping: 0
Speed minimum: 0.0 km/hr

3413660 data points processed in cocO2.xyz
3413660 total data points processed

Making raw grid...
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Doing spline interpolation with 603120 data points...

Total number of bins: 5813184
Bins set using data: 603120
Bins set using interpolation: 172327
Bins not set: 5037737
Maximum number of data in a bin: 671
Minimum value: 2.36 Maximum value: 83.71
Minimum sigma: 0.00001 Maximum sigma: 5.54245

Outputting results...

executing rnbm_grdplot...
mbrngrdplot -Icpt im.grd -Gl -C -D -V -L"File cpt im.grd - Bathyrnetry Grid:Depth
(rn)'

Program Status:

GMT Version:
Version 3.4.1

Plot Style:
Color Fill
Contours
Horizontal Color Scale

Input Files:
Data GRD File: cpt_lm.grd
Intensity GRD List File:

Output Files:
Output plot name root: cpt_lrn.grd
Color pallette table: cpt_lm.grd.cpt
Plotting shellscript: cpt_lrn.grd.cmd
Plot file: cptlm.grd.ps

Plot Attributes:
Plot width: 3.9663
Plot height: 7.5000
Page size: a
Page width: 8.5
Page height: 11

Projection: -Jm247.89
Axes annotation: 1 Sc/i 5c:. "File cpt_1 m. grd - Bathymetry Grid":
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Orientation:
Number of colors:
Color Pallette:
Colors reversed

Grid Data Attributes:
Longitude mm max:
Latitude mm max:
Data mm max:

portrait
11

Haxby Colors

-170.7040 -170.6880
-14.3375 -14.3080

2.36 83.71

Primary Grid Plotting Controls:
Contour control: 2.5
Color start datum: 0.000000
Color end datum: 87.500000
Color datum interval: 8.75 0000

Miscellaneous Plotting Controls:
Contour pen attributes: -Wclp

GMT Default Values Reset in Script:
MEASURE UNIT inch
PAPER_MEDIA archA+
ANOT FONT Helvetica
LABEL_FONT Helvetica
HEADER_FONT Helvetica
ANOT_FONT_SIZE 8

LABEL_FONT_SIZE 8
HEADER_FONT_SIZE 10
FRAME_WIDTH 0.075
TICK_LENGTH 0.075
PAGE_ORIENTATION LANDSCAPE
COLOR_BACKGROUND 0/0/0
COLOR_FOREGROUND 255/255/255
COLOR_NAN 255/255/255
DEGREE_FORMAT 3

Plot generation shellscript <cpt_lm.grd.cmd> created.

Instructions:
Execute <cpt_1 m.grd.cmd> to generate Postscript plot <cpt_1 m.grd.ps>.
Executing <cpt_lrn.grd.cmd> also invokes ghostview to view the plot on the screen.

Done.



Specific to TAEMA BANK (EASTERN)

mbgrid -Idatalist -El / 1/meters -R- 170.6625/-i 70.6291/-i 4.3241-14.3 -OtaeO2 1 rnd -N -
Al -ClO -V

Program mbgrid
Version $Id: rnbgrid.c,v 5.5 2002/04/06 02:53:45 caress Exp $
MB-system Version 5.0.betal8

MB GRID Parameters:
List of input files: datalist
Output fileroot: tae02lmd
Input Data Type: Bathymetry
Gridding algorithm: Gaussian Weighted Mean
Grid projection: Geographic
Grid dimensions: 3604 2656
Grid bounds:

Longitude: -170.6625 -170.6291
Latitude: -14.3240 -14.3000

Working grid dimensions: 3604 2656
Working Grid bounds:
Longitude: -170.6625 -170.6291
Latitude: -14.3240 -14.3000

Longitude interval: 0.000009 degrees or 1.000115 m
Latitude interval: 0.000009 degrees or 1.000155 m
Specified Longitude interval: 1.000000 meters
Specified Latitude interval: 1.000000 meters
Input data bounds:
Longitude: -170.6959 -170.5957
Latitude: -14.3480 -14.2760

Gaussian filter l/e length: 1.000000 grid intervals
Spline interpolation applied with clipping dimension: 10
Spline tension (range 0.0 to infinity): 10000000000.000000
Grid format 3: GMT version 2 grd (netCDF)
NaN values used to flag regions with no data
MBIO parameters:
Ping averaging: 1

Longitude flipping: 0
Speed minimum: 0.0 km/hr

7384407 data points processed in 2002_taema_xyz
7384407 total data points processed

Making raw grid...



Doing spline interpolation with 2013590 data points...

Total number of bins: 9572224
Bins set using data: 2013590
Bins set using interpolation: 883618
Bins not set: 6675016
Maximum number of data in a bin: 100
Minimum value: 8.35 Maximum value: 126.46
Minimum sigma: 0.00050 Maximum sigma: 13.52085

Outputting results...

executing mbrn_grdplot...
rnbrngrdplot -Itae_O2jmd.grd -Gi -C -D -V -L"File tae_O2jmd.grd - Bathymetry
Grid:Depth (rn)'

Program Status:

GMT Version:
Version 3.4.1

Plot Style:
Color Fill
Contours
Horizontal Color Scale

Input Files:
Data ORD File: tae02lmd.grd
Intensity GRD List File:

Output Files:
Output plot name root: tae_O2jmd.grd
Color pallette table: tae_02_1 md.grd.cpt
Plotting sheliscript: tae_02_1 rnd.grd.cmd
Plot file: tae_O2jmd.grd.ps

Plot Attributes:
Plot width: 6.708
Plot height: 5.000
Page size: a
Page width: 11

Page height: 8.5
Projection: -Jm23 .14
Axes annotation: 30/30c:."File tae_02_lmd.grd Bathymetry Grid":
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Orientation:
Number of colors:
Color Pallette:
Colors reversed

Grid Data Attributes:
Longitude mill max
Latitude mm max:
Data mm max:

landscape
11

Haxby Colors

-170.6620 -170.6290
-14.3240 -14.3000
8.347 126.5

Primary Grid Plotting Controls:
Contour control: 5

Color start datum: 0.000000
Color end datum: 150.000000
Color datum interval: 15.000000

Miscellaneous Plotting Controls:
Contour pen attributes: -Wclp

GMT Default Values Reset in Script:
MEASURE UNIT inch
PAPER_MEDIA archA+
ANOT FONT Helvetica
LABEL_FONT Helvetica
HEADER_FONT Helvetica
ANOT_FONT SIZE 8

LABEL_FONT_SIZE 8

HEADER_FONT_SIZE 10
FRAME_WIDTH 0.075
TICK_LENGTH 0.075
PAGE_ORIENTATION LANDSCAPE
COLOR_BACKGROUND 0/0/0
COLOR_FOREGROUND 255/255/255
COLOR_NAN 255/255/255
DEGREE_FORMAT 3

Plot generation shellscript tae_02_1md.grd.cmd> created.

Instructions:
Execute <tae_02_1 md. grd.cmd> to generate Postscript plot <tae_02_1 md. grd.ps>.
Executing <tae_02_lmd.grd.cmd> also invokes ghostview to view the plot on the

screen.

Done.
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Appendix D

Bill Zone and Structure Classification Methods and Code

> Data Analysis

o Use ArcGMT to convert bathymetric grids into Arc compatible grids

o Multiply bathymetry by -ito make negative z values

o Use ArcToolbox to project grid to UTM WGS84

o Use ArcGIS Spatial Analyst to make slope grid with these parameters:
Input surface bathymetry
Output measurement degree
Z factor copy output cell size
Output raster name slope grid

o Use ArcGIS Spatial Analyst raster calculator to make bathymetric position
index grids

int((bathy focalmean(bathy, annulus, irad, orad)) + 0.5)

OR
int((bathy focalmean(bathy, circle, rad)) + 0.5)

Study Resolution circle, Radius Fine Processing
Site (meters) annulus, Scalefactor Time

or (minutes)
rectangle

Fagatele 1 circle 20 20 1

Bay_______
Coconut 1 circle 10 10 2
Point_________
Taema 1 circle 20 20 8

Bank
2002
(Eastern)
Taema 1 20 20 3

Bank circle
2001
(Western)

Table 1: Parameters used for calculating fine scale bathymetric position index grids
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Study Resolution circle, Irad Orad Broad Process-
Site (meters) annulus, Scale- ing Time

or factor (mm.)
rectangle

Fagatele 3 annulus 16 83 250 3

Bay________
Coconut 1 circle 70 70 36
Point__________
Taema 3 annulus 16 83 250 10
Bank
2002
(Eastern)
Taema 3 16 83 250 5

Bank annulus
2001
(Western)

Table 2: Parameters used for calculating broad scale bathymetric position index grids

o Use ArcGIS Spatial Analyst raster calculator to make standardized

bathymetric position index grids

int((((BPI mean) I stdv) * 100) + .5)

o Use Arclnfo Grid (AML) to make BPI zone and structure grids (see code
for each study site below)



BPI Zones:

(1) Crests, (2) Depressions, (3) Flats, (4) Slopes

Fagatele Bay NMS surveyed in 2002 ******

if(nfbo2_tpi25os >= 100) fb_zns = 1
else if (nfbo2_tpi25os <= -100) fb zns 2
else if(nfb02_tpi25Os> -100 and nthO2 tpi25os < 100 and nfb02_slp <= 5) fb_zns = 3
else if (nfb02 tpi250s > -100 and nthO2_tpi25os < 100 and nfbO2_slp> 5) fb_zns = 4
endif

Coconut Point surveyed in 2002

if (ncpt_tpi7ost >= 100) cpt_zns = 1
else if (ncpt tpi70st <= -100) cpt zns 2
else if (ncpt tpi70st> -100 and ncpt_tpi70st < 100 and nept_sip <= 5) cpt_zns 3

else if (ncpt_tpi7Ost> -100 and ncpt_tpi70st < 100 and ncpt_slp> 5) cpt_zns = 4
endif

Taema Bank (Eastern) surveyed in 2002

if(nto2tpi25ost >= 100) tae02_zns = 1
else if (ntO2_tpi25ost <= -100) taeO2_zns 2
else if (ntO2_tpi250st> -100 and ntO2_tpi25Ost < 100 and ntae02_slp <= 5) tae02 zns 3

else if (ntO2_tpi25ost> -100 and ntO2 tpi250st < 100 and ntae02_slp> 5) taeO2_zns = 4
endif

Taema Bank (Western) surveyed in 2001

if(nt0lbpi250st>= 100) taeOl zns = 1
else if (ntOl_bpi25ost <= -100) tae0l_zns = 2
else if(ntOl_bpi25ost> -100 and ntOl bpi25Ost < 100 and ntaeol_slp <= 5) tae0l zns =
3

else if (ntOl bpi25ost> -100 and ntOl_bpi25ost < 100 and ntae0l sip> 5) tae0l_zns 4
endif



Structures:

(1) narrow depression, (2) local depression on flat, (3) lateral midslope depression,
(4) depression on crest, (5) broad depression with an open bottom, (6) broad flat, (7)
shelf, (8) open slopes, (9) local crest in depression, (10) local crest on flat, (11) lateral
midsiope crest, (12) narrow crest, and (13) steep slope.

Fagatele Bay NMS surveyed in 2002 ******
if(nfbo2_tpi2ost <= -100 and nfbO2_tpi250s <= -100) fbO2_20x250 = 1
else if (nfb02 tpi20st <= -100 and nfb02_tpi250s > -100 and nthO2_tpi250s < 100 and
nfb02 sip <= 5 ) fbO2_20x250 =2
else if (nfbO2_tpi2ost <= -100 and nfb02_tpi25os> -100 and nfbo2_tpi250s < 100 and
nfb02 sip> 5) fbO2_20x250 = 3
else if(nfbo2_tpi2Ost <= -100 and nfbo2_tpi25Os >= 100) fbO2 20x250 = 4
else if (nf'b02 tpi20st> -100 and nthO2_tpi2Ost < 100 and nfbO2_tpi2s0s < -100)
fb0220x2505
else if (nfbO2_tpi2ost> -100 and nfbO2_tpi2Ost < 100 and nfb02_tpi25Os> -100 and
nfb02_slp <= 5 and nfbO2_lrn_utm < -22) fbO2_20x250 = 6
else if(nthO2_tpi2ost> -100 and nfbO2_tpi20st < 100 and nfbO2_tpi25os> -100 and
nthO2_slp <= 5 and nfbO2jm_utm >= -22) th02_20x250 = 7
else if (nfbo2_tpi2ost> -100 and nIbO2_tpi2Ost < 100 and nfbo2 tpi250s> -100 and
nfbo2_sip> 5 and nTh02_slp <= 70) fbO2_20x250 = 8
else if (nfbO2_tpi20st >= 100 and nfb02 tpi250s <= -100) fbO2_20x250 = 9
else if (nfbO2 tpi20st >= 100 and nthO2 tpi250s> -100 and nfb02_tpi250s < 100 and
nfb02_slp <= 5) fbO2_20x250 = 10
else if(nfbo2_tpi20st >= 100 and nfbO2_tpi25os> -100 and nfb02_tpi250s < 100 and
nfbO2 sip> 5) fbO2_20x250 = 11
else if (nfbo2_tpi2ost >= 100 and nfb02_tpi250s >= 100) fbO2_20x250 = 12
else if(nfoO2_tpi20st> -100 and ntbO2_tpi2ost < 100 and nIbO2 tpi250s> -100 and
nfb02_slp > 70) fbO2_20x250 = 13
endif

Coconut Point surveyed in 2002

if(ncpt_tpilost <= -100 and ncpt_tpi7ost <= -100) cpt_10x70 = 1
else if(ncpt_tpilost <= -100 and ncpt_tpi70st> -100 and ncpt_tpi7ost < 100 and ncpt_slp
<= 5 ) cpt_10x70 = 2
else if(ncpt_tpilost <= -100 and ncpt_tpi70st> -100 and ncpt_tpi70st < 100 and ncpt_slp
> 5) cpt_10x70 = 3
else if (ncpt_tpi 1 Ost <= -100 and ncpt_tpi7ost >= 100) cpt_1 0x70 = 4
else if (ncpt_tpilost> -100 and ncpt_tpil0st < 100 and ncpt tpi7ost < -100) cpt_10x70
=5



91

else if(ncpt_tpilost> -100 and ncpt_tpilOst < 100 and ncpt_tpi7ost> -100 and ncpt_slp
<= 5 and ncpt_lm_utm < -22) cpt 10x70 =6
else if (ncpt_tpilOst> -100 and ncpt tpil0st < 100 and ncpt_tpi70st> -100 and ncpt_slp
<= 5 and ncpt_lm_utm >= -22) cpt_10x70 = 7
else if (ncpt_tpi 1 Ost> -100 and ncpt_tpi 1 Ost < 100 and ncpt_tpi7Ost> -100 and ncpt_slp
> 5 and ncpt_slp <= 70) cpt_10x70 = 8
else if (ncpt_tpilost >= 100 and ncpt tpi7ost <= -100) cpt_lOx7O = 9
else if (ncpt_tpil Ost >= 100 and ncpt tpi70st> -100 and ncpt tpi70st < 100 and ncpt_slp
<= 5) cpt_10x70 = 10
else if (ncpt_tpi 1 Ost >= 100 and ncpt tpi70st> -100 and ncpt_tpi70st < 100 and ncpt_slp
>5) cpt_10x70 = 11
else if (ncpt tpi lOst >= 100 and ncpt_tpi70st >= 100) cpt_1 0x70 = 12
else if (ncpt tpil0st> -100 and ncpt_tpil0st < 100 and nept_tpi70st> -100 and ncpt_slp
> 70) cpt_10x70 = 13
endif

Taema Bank (Eastern) surveyed in 2002 ********************************

if(nto2tpi2ost <= -100 and ntO2_tpi250st <= -100) tae02_20x250 = 1
else if (ntO2_tpi2ost <= -100 and ntO2_tpi250st> -100 and ntO2_tpi250st < 100 and
ntae02_slp <= 5 ) tae02_20x250 = 2
else if (ntO2_tpi2ost <= -100 and ntO2_tpi250st> -100 and ntO2_tpi250st < 100 and
ntae02_slp> 5) taeO2_20x250 = 3
else if (ntO2_tpi2ost <= -100 and ntO2_tpi250st >= 100) taeO2_20x250 = 4
else if (ntO2_tpi2ost> -100 and ntO2_tpi2ost < 100 and ntO2_tpi25 Ost <= -100)
tae0220x250 = 5
else if (ntO2_tpi20st> -100 and ntO2_tpi20st < 100 and ntO2 tpi250st> -100 and
ntaeO2_slp <= 5 and ntae02_lm_utm < -22) tae02_20x250 = 6
else if (ntO2_tpi2ost> -100 and ntO2_tpi2ost < 100 and ntO2_tpi25Ost> -100 and
ntaeo2_slp <= 5 and ntae02_lm_utm >= -22) tae02 20x250 = 7
else if (ntO2_tpi20st> -100 and ntO2_tpi2Ost < 100 and ntO2_tpi250st> -100 and
ntae02_slp> 5 and ntae02 slp <= 70) tae02_20x250 = 8
else if(ntO2_tpi2ost >= 100 and ntO2_tpi250st <= -100) tae02_20x250 = 9
else if(ntO2_tpi2ost > 100 and ntO2_tpi250st> -100 and ntO2_tpi25Ost < 100 and
ntae02_slp <= 5) tae02_20x250 = 10
else if (ntO2_tpi2ost >= 100 and ntO2_tpi250st> -100 and ntO2_tpi25Ost < 100 and
ntae02_slp> 5) tae02_20x250 = 11
else if (ntO2_tpi2Ost >= 100 and ntO2 tpi25ost >= 100) taeO2_20x250 = 12
else if(ntO2_tpi2Ost> -100 and ntO2_tpi20st < 100 and ntO2 tpi250st> -100 and
ntaeo2_slp> 70) tae02 20x250 13
endif
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Taema Bank (Western) surveyed in 2001 ********************************

if(ntolbpi2Ost <= -100 and ntOl bpi25ost <= -100) tae0l_20x250 1

else if (ntOl_bpi2ost <= -100 and ntOl bpi250st> -100 and ntOl_bpi250st < 100 and
ntae0l sip <= 5 ) taeOl 20x250 = 2
else if (ntOl bpi20st <= -100 and ntOl_bpi25Ost> -100 and ntOl bpi250st < 100 and
ntaeol_sip> 5) tae0l_20x250 = 3

else if (ntOl_bpi2ost <= -100 and ntOl_bpi25Ost >= 100) tae0l_20x250 4
else if (nt0 1 bpi20st> -100 and nt0 1 _bpi20st < 100 and nt0 lbpi250st <= -100)
taeOl2Ox25O = 5

else if (ntOl_bpi20st> -100 and ntOl_bpi20st < 100 and ntOl_bpi250st> -100 and
ntae0l_slp <= 5 and ntae0l lmutm < -22) tae0l_20x250 6
else if (ntOl_bpi20st> -100 and ntOl_bpi20st < 100 and ntOl_bpi250st> -100 and
ntaeOl_slp <= 5 and ntae0l_lm_utm >= -22) tae0l_20x250 = 7
else if(ntOl_bpi2ost> -100 and ntOl_bpi20st < 100 and ntOl_bpi250st> -100 and
ntae0l_slp> 5 and ntae0l sip < 70) tae0l_20x250 = 8

else if(ntOi_bpi2ost >= 100 and ntOl_bpi25Ost <= -100) tae0l_20x250 = 9

else if (nt0 1 _bpi20st >= 100 and nt0 1_bpi250st> -100 and nt0 1_bpi25 Ost < 100 and
ntaeOl sip < 5) taeOl_20x250 = 10
else if(ntOl_bpi2ost >= 100 and ntOl_bpi25ost> -100 and ntOl bpi250st < 100 and
ntae0 1_sip> 5) tacO 1_20x250 = 11

else if (ntOl bpi2ost >= 100 and ntOl_bpi25ost >= 100) tae0l_20x250 = 12
else if (ntOl_bpi20st> -100 and ntOl bpi20st < 100 and nt0i_bpi25Ost> -100 and
ntae0l_slp> 70) tacO 1_20x250 = 13

endif
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To open a GMT grid in DMagic:

Choose File Import Surface
> The Importing Surface dialog box will open

+ Browse to the file you want to import and click open
: In the Choose File Type pull down list select GMT GRD/NetCDF

Click Scan for Information
The Data Dimensions and XYZ information will be filled in

: Select Output a DTM (.dtm)
Click Convert and Save File

+ Name the file and click Save
> The dialog box will close

To grid an XYZ file to open in DMagic:

+ Choose File Import XYZ Data
> The Gridder dialog box will open

+ Choose File Add file to grid
> The Add Files to Grid dialog box will open

+ Browse to the xyz file (should have positive z values) and click Open
+ Make sure the File Format is correct for your data set

> Check the order of your variables in the XYZ file (e.g. x y z or y x z)
+ Change the cell size to the desired size (e.g. if you have lat, long, depth then a 1 meter

grid would have a cell size of 0.00001 and a 3 meter grid would have a cell size of
0.00003)
Click Scan File
> The Notifier box will let you know the progress as the points are scanned
> When the scan finishes, the Bounding Box, Bounds, Data Range and DTM

Dimensions will be filled in (check to make sure these look right, if they don't try
correcting the cell size and rescan the file)

+ Click Convert
> The Notifier box will let you know the progress as the points are converted

: A DTM is created
Choose File 3 Export DTM/GEO file

+ Choose File Quit to close the Gridder

To open and view a DTM and GEO file in DMagic:

+ Choose File Open Project
The Open Project dialog box will open

+ Browse to the .dtm file you just created and click Select
> The .geo will automatically be opened with the .dtm

+ The .dtm and an associated .geo file will be listed in the Data Components box
+ Click the single arrow to display the .dtm
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Click the double arrow to display the .dtm with its georeferenced information (.geo)

To add a Scalar file in DMagic:

+ Choose File -) Import Surface
> The Importing Surface dialog box will open

+ Browse to the file you want to import and click open
+ In the Choose File Type pull down list select GMT GRD/NetCDF
+ Click Scan for Information

The Data Dimensions and XYZ information will be filled in
+ Select Output a Scalar (.scalar)
: Click Convert and Save File
+ Name the file and click Save (choose a name that will indicate which .dtm the scalar

should match (e.g. bathy_l m slope. scalar matches bathy_l m.dtm))

To make a Scientific Data (.sd) file for 3D visualization in Fledermaus:

Follow steps above then proceed

Make Shade file

Click Surface Shader
> The Surface Shader dialog box will open

+ As the Height File choose the .dtm that you just created
OPTIONAL: Overlay a Scalar

This may be a slope, classified, or other file that you want bathymetry to be
shaded with

+ Click Start Rendering
> Experiment with the Shadow Direction and Lighting Parameters to pick the best

shade for you data set (this is how it will be shaded in Fledermaus)
> Click Start Rendering again to see the changes

+ When you like the shade, click Save Shade (it is helpful to name the Output File the
same as the .dtm and .geo)

+ Click Close

Assemble Fledermaus Object

+ Click Assemble Fledermaus Objects
+ The Assemble Fledermaus Objects dialog box will open

Choose the .dtm, .geo, and .shade file that you worked with in the steps above
+ OPTIONAL: Choose an Overlaid Scalar



This will add a fourth value to the view in Fledermaus. The values from the
Scalar file will be displayed with the x, y, z information. They will not be used to
shade the object unless you overlaid the scalar when making the Shade file
The Overlaid Scalar has to have the same dimensions at the .dtm, .geo, and .shade
files. If they have different dimensions, follow the directions for the resampler
below

Click Build Object
+ Click Done
+ The Fledermaus Objects box will now contain the .sd that you just created

Highlight the .sd file and click Run Fledermaus
> The Options for Running Fledermaus dialog box will open
Use the defaults and click Start Fledermaus
> Fledermaus will open with the .sd file open

+ Click Geo-Reference
+ Now you can view the file in 3D with Fledermaus

To Resample a file:

+ The question mark button will open a Browsing a TDR File dialog box that displays
all of the tagged information associated with the highlighted file (e.g. dimensions,
data type, etc.)

+ Make note of the dimensions of the grids that you want to match each other
+ Open a command line window
+ Change to the drive where your IVS folder is stored (it will have a bin folder in it

with several executables in it) (e.g. C:!)
+ Type resampler h to view the usage

Resampler
< -image <inputlmageFile> >
< -in <inputTDRFile> >
< -out <outputFileName> >
< -scale <scaleFactor> <-dims <numRows> <nurnCols>
{ -filter <box triangle

I

bspline
I

hermite lanczos3
I

mitchell> I

[ -h]
> Resampler takes in an image or a dtm input file and rescales it to the specified

output dimensions using the specified filter. The output size can be controlled by
either specifying the zoom scale factor which preserves the aspect of the source
file or via the dims option which provides an arbitrary non-aspect preserving
scaling.

4 Here are examples of the code you may use:
C:\ivs\bin>resampler in Z:\Projects\bathy m.dtm out
Z:\Projects\bathy_1 mslope_r.dtrn dims 616 627 filter mitchell
C:\ivs\bin>resampler in Z:\Projects\bathy lm.scalar out
Z:\Proj ects\bathy_l m_sloper. scalar dims 1848 1834 filter Mitchell
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After resampling files close the command line window and open them with File
Open Project in DMagic.

If you resampled a DTM, you may have to create a .geo file for it by clicking the
Create/Edit Geo-Referencing

A Create/Edit Geo-Referencing Objects dialog box will open
Make sure the Height File is the correct DTM and name the Object the same
thing as the DTM
Click Save Object

To Export an ArcView ASCII file from DMagic:

+ Choose File Export XYZ
The Export XYZ dialog box will open

+ Browse to the file you want to export
+ Choose the Format: Export ArcView Ascii Grid
+ Name the file (it will save a .asc file)
+ Click Save
+ You may now use ArcToolbox to convert the Ascii file to a Grid or other format to

bring the data into ArcView, Arclnfo, ArcExplorer or ArcGIS



Appendix F

Fledermaus 3D Profile Analysis of Structures

3D Visualization Profile Analysis performed with Fledermaus for structures in Fagatele
Bay National Marine Sanctuary, Tutuila, American Samoa. The white arrows point to
the profile transect lines on the images. In order to view the zones at the same scale, a
common length for the transect lines were used. The transect line for each zone is
approximately 80.5 meters long.
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Appendix G

Rugosity Classification Maps

Rugosity is displayed in Universal Transverse Mercator, W0S84. The high-resolution (1
m) bathymetry used to derive the rugosity for Fagatele Bay National Marine Sanctuary,
Coconut Point and Taema Bank (Eastern) was surveyed in November of 2002. The high-
resolution (1 m) bath ymetry used to derive the rugosity for Taema Bank (Western) was
surveyed in April and May of 2001. Classifications are based on a scheme extending
attributes used by the Coral Reef Ecosystem Investigation for towed diver survey videos.
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Appendix H

Bathymetric Position Index (BPI) Zone Classification Maps

BPI Zones are displayed in Geographic Coordinate System, WGS84. The high-
resolution (1 m) bathymetry used to derive the zones for Fagatele Bay National Marine
Sanctuary, Coconut Point and Taema Bank (Eastern) was surveyed in November of 2002.
The high-resolution (1 m) bathymetry used to derive the zones for Taema Bank
(Western) was surveyed in April and May of 2001. Classifications are based on a scheme
developed to combine slope and a broad scale bathymetric position index.
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Appendix I

Structure Classification Maps

Structures are displayed in Geographic Coordinate System, WG584. The high-resolution
(1 m) bathymetry used to derive the structures for Fagatele Bay National Marine
Sanctuary, Coconut Point and Taema Bank (Eastern) was surveyed in November of 2002.
The high-resolution (1 m) bathymetry used to derive the structures for Taema Bank
(Western) was surveyed in April and May of 2001. Classifications are based on a scheme
developed to combine bathymetry, slope, and two scales of bathymetric position index.
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Appendix J

Glossary

Terms

Backscatter: Recorded values of the intensity of acoustic return

Bathymetric A scale dependent index representing a grid cell's location within
Position Index: seascape relative to its local surroundings

Biodiversity: In an ecosystem, variability among living organisms from all
sources, sometimes measured by the total number of species or
other taxonomic groupings, and their relative abundances (Miller
and Crosby 1998)

Benthic: Of or relating to the bottom under a body of water

Bathymetry: Measurements of ocean depths to determine the shapes and
contours of the sea floor (Miller and Crosby 1998)

BPI Zone: A surficial characteristic of the seafloor based on a bathymetric
position index value range at a broad scale and slope values

Ground truthing: Measurements conducted on the ground or at sea to calibrate
observations made from satellites or aircraft (Miller and Crosby
1998) or acoustics

Habitat: A set of conditions where a species is found to occupy

Shallow: Less than 30 meters depth

Topographic A scale dependent index representing a grid cell's location within a
Position Index: landscape relative to its local surroundings

Rugosity: A ratio of surface area to planar area that identifies roughness, or
bumpiness.

Slope: A measure of steepness between locations within a seascape

Structure: A surficial characteristic of the seafloor based on a bathymetric
position index value range at a combined fine scale and broad
scale, slope values and depth
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DVD Readme File List
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Emily Ruth Lundblad for the degree of
Master of Science in
Geography presented
on June 7, 2004
Title: The Development and Application of Benthic Classifications for Coral Reef
Ecosystems Below 30 m Depth using Multibeam Bathymetry: Tutuila, American Samoa

This DVD contains raster grid files as zipped .eOO files with metadata (.html) and
thumbnails (.jpg). The raster grids are in Universal Transverse Mercator WGS84. Final
maps are also included. Finally, scientific data (.sd) files and GMT grids (.grd) are
included with iView3D, a free viewer from Interactive Visualization Systems
(http :/Iwww.ivs.unb.ca) for three-dimensional data.

Zipped Raster Grids (.eOO and .html and .jpg and .lyr)

Layer Files
Rugosity-Surface Ratio .lyr
Structures-new.lyr
Zones.lyr

Fagatele Bay National Marine Sanctuary
Bathyrnetry 1 m (nfb02jm_utm)
Bathymetry 3 iii (nfbO2_3m_utm)
Bathymetric Position Index (BPI) Zones (fb_zns)
Rugosity (f'b02_rug)
Structures (th02_20x250)
Slope (nf'b02_slp)
Aspect (nfb02_asp)
Fine Scale BPI (nfb02_tpi20)
Broad Scale BPI (nfbo2_tpi25O)
Standardized Fine Scale BPI (nTh02_tpi2ost)
Standardized Broad Scale BPI (nfb02tpi25Os)
Backscatter (GeoTIFF file) (200lbackscatterlm)
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Coconut Point
Bathymetry 1 m (ncpt_1 m_utm)
Bathymetric Position Index (BPI) Zones (cpt_zns)
Rugosity (cpt_rug)
Structures (cptl Ox 70)
Slope (ncpt_slp)
Aspect (ncpt asp)
Fine Scale BPI (ncpt_tpilO)
Broad Scale BPI (ncpt_tpi7O)
Standardized Fine Scale BPI (ncpt_tpi lOst)
Standardized Broad Scale BPI (ncpt_tpi7ost)

Taema Bank (Eastern) 2002
Bathymetry 1 m (tae02_lm_utm)
Bathymetry 3 m (taeO2_3m_utm)
Bathymetric Position Index (BPI) Zones (taeO2_zns)
Rugosity (tae02_rug)
Structures (tae0220x250)
Slope (ntaeO2 sip)
Aspect (ntaeO2_asp)
Fine Scale BPI (ntO2_tpi2o)
Broad Scale BPI (ntO2tpi2SO)
Standardized Fine Scale BPI (ntO2_tpi2ost)
Standardized Broad Scale BPI (ntO2_tpi25ost)

Taema Bank (Western) 2001
Bathymetry 1 iii (ntae0 1_i m_utm)
Bathymetry 3 m (ntae0 1_3rn_utrn)
Bathymetric Position Index (BPI) Zones (tae0 1 _zns)
Rugosity (ntaeO 1_rug)
Structures (tae0 120x250)
Slope (ntae0 1_sip)
Aspect (ntaeO 1_asp)
Fine Scale BPI (ntOl_bpi2o)
Broad Scale BPI (ntOl_bpi25O)
Standardized Fine Scale BPI (ntOl_bpi2ost)
Standardized Broad Scale BPI (ntOl_bpi25ost)
Backscatter (Ge0TIFFs) (200 Itaemabsl rn_i 00246), (2001 _taema_bs_1 m)

Maps (.jpg and .pdt)

Fagatele Bay National Marine Sanctuary
Bathymetric Position Index (BPI) Zones (FB-zones-layout-new)
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Structures (FB-struct-layout-cite)
Rugosity (FB-rugos-layout-cite)

Coconut Point
Bathymetric Position Index (BPI) Zones (cpt-zones-layout-new
Structures (cpt_struct2-layout-cite)
Rugosity (cptrugos-layout-cite)

Taema Bank 2002
Bathymetric Position Index (BPI) Zones (tae-zones-layout-new)
Structures (tae-struct2-layout-cite)
Rugosity (tae-rugos-layout-cite)

Taema Bank 2001
Bathymetric Position Index (BPI) Zones (taeO 1-zones-layout-new)
Structures (tae0 1 -struct-layout-cite)
Rugosity (tae0 1 -rugo s-layout-cite)

Fledermaus scientific data (.sd) files and GMT grids (.grd)

Color Map files (.cmap)
rug2.cmap
zones.cmap

Fagatele Bay National Marine Sanctuary
Bathymetry 1 m with slope scalar (nfb02_1 rn_utinr)
Bathymetric Position Index (BPI) Zones (th_zns)
Structures (fb0220x250)
Rugosity (1b02_rugr)

Coconut Point
Bathymetry 1 m with slope scalar (ncpt_lm_utm)
Bathymetric Position Index (BPI) Zones (cpt_zns)
Structures (cpt_1 0x70)
Rugosity (cptrugnewr)

Taema Bank 2002
Bathymetry 1 m with slope scalar (ntae02_1 m_utmr)
Bathymetric Position Index (BPI) Zones (taeO2_zns)
Structures (tae0220x250)
Rugosity (taeo2_rug_newr)

Taema Bank 2001
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Bathymetry 1 m with slope scalar (ntaeO ljm_utmr)
Bathymetric Position Index (BPI) Zones (ntaeOl_zns)
Structures (ntaeO 120x250)
Rugosity (ntaeO 1_rugr)




